
BESA Statistics 
User Manual



 
 

 

 

 

BESA® 

Statistics 2.1 
 

 

 

 

User Manual 
 

 

 

 

 

 

Copyright and Trademarks 

The BESA Statistics product and its documentation are copyrighted © 2025 by BESA GmbH. All rights 
reserved. 

BESA® is a registered trademark of BESA GmbH, Graefelfing, Germany. 

All other trademarks, brands and product names used in this guide are trademarks of the respective 
owners. 

 

 

 

Author(s):  Harald Bornfleth, Jae-Hyun Cho, Robert Spangler 

Document:   BESA Statistics 2.1 - User Manual 

Revision number: 005/01.2025 

Revision date:  2025-01-31 

 

 
  



 Table of Contents  

2  

Table of Contents 
1. Notes .................................................................................................................... 5 

2. Intended Use ........................................................................................................ 5 

3. System Requirements ......................................................................................... 5 

4. Disposal Information ........................................................................................... 6 

5. Installation and Initial Setup ............................................................................... 6 

5.1. Before Setup ................................................................................................. 6 

5.2. Installation ..................................................................................................... 6 

5.3. Initial setup .................................................................................................... 6 

5.3.1. Connect the BESA License key ............................................................................ 6 

5.3.2. Start the Program ................................................................................................. 8 

5.3.3. Specify the BESA Statistics Data Folder ............................................................... 8 

6. Introduction ....................................................................................................... 10 

6.1. Features of BESA Statistics......................................................................... 10 

7. Statistical Methods ............................................................................................ 11 

7.1. Preliminary Tests and Subsequent Permutation .......................................... 11 

7.1.1. Preliminary t-Test - parametric ............................................................................ 11 

7.1.2. Preliminary One-Way Analysis of (Co)Variance (ANOVA / ANCOVA) – parametric 
(F-test) 12 

7.1.3. Preliminary Correlation ....................................................................................... 13 

7.2. Permutation Test (non-parametric) .............................................................. 14 

7.3. Post-Hoc Permutation Test (non-parametric) – Scheffe’s Test .................... 17 

8. The Workflow Concept ...................................................................................... 20 

9. Elements of the BESA Statistics Screen ......................................................... 21 

9.1. Workflow Window ........................................................................................ 21 

9.2. Main Window ............................................................................................... 21 

9.3. Interaction Window ...................................................................................... 21 

9.3.1. Notes.................................................................................................................. 22 

9.4. Information Window ..................................................................................... 22 

10. Program Bars..................................................................................................... 22 

10.1. Menu Bar..................................................................................................... 22 

10.1.1. File Menu ........................................................................................................... 22 

10.1.2. Edit Menu ........................................................................................................... 23 

10.1.3. View Menu ......................................................................................................... 23 

10.1.4. Export Menu ....................................................................................................... 23 

10.1.5. Help Menu .......................................................................................................... 24 

10.2. Title Bar ....................................................................................................... 24 

10.3. Toolbar ........................................................................................................ 24 

10.4. Caption ........................................................................................................ 24 

11. How to use BESA Statistics .............................................................................. 25 



  Table of Contents 

3 

11.1. Starting BESA Statistics .............................................................................. 25 

11.1.1. Welcome Screen ................................................................................................ 25 

11.2. The Workflow of BESA Statistics ................................................................. 25 

11.2.1. The Workflow ..................................................................................................... 25 

11.2.2. Select Project – Parametric Test ......................................................................... 25 

11.2.3. Set Project Targets: Data Type ........................................................................... 26 

11.2.4. Set Project Targets for Parametric Test .............................................................. 26 

11.2.5. Define Experimental Design ............................................................................... 27 

11.2.6. Loading Data ...................................................................................................... 29 

11.2.7. Set Parameters, Preliminary Test ....................................................................... 35 

11.2.8. Perform Statistics ............................................................................................... 38 

11.2.9. Post-Hoc Testing – ANOVA / ANCOVA only ....................................................... 40 

11.3. Important Dialogs ........................................................................................ 41 

11.3.1. Select the BESA Statistics Data Folder ............................................................... 42 

11.3.2. Open Projects .................................................................................................... 42 

11.3.3. Finish, Save, and Close Projects ........................................................................ 43 

11.3.4. Delete Projects ................................................................................................... 44 

11.3.5. Select Files ........................................................................................................ 45 

12. Specific Issues when Analyzing ERP / ERF data ............................................ 46 

12.1. Load Data .................................................................................................... 46 

12.2. Set Parameters ............................................................................................ 46 

12.3. Perform Statistics ........................................................................................ 46 

13. Specific Issues when Analyzing Source Waveforms ..................................... 47 

13.1. Load Data .................................................................................................... 47 

13.2. Set Parameters ............................................................................................ 47 

13.3. Perform Statistics ........................................................................................ 48 

14. Specific Issues when Analyzing Time Frequency Data ................................. 48 

14.1. Set Project Targets ...................................................................................... 48 

14.2. Load Data .................................................................................................... 49 

14.3. Set Parameters ............................................................................................ 49 

14.4. Perform Statistics ........................................................................................ 50 

14.4.1. Time-Frequency Mapping in TFC ERP / ERF Data ............................................. 51 

15. Specific Issues when Analyzing Image Data .................................................. 52 

15.1. Load Data .................................................................................................... 52 

15.2. Set Parameters ............................................................................................ 53 

15.3. Perform Statistics ........................................................................................ 53 

15.4. Multi-Slice view ............................................................................................ 54 

16. Exporting Images and Results......................................................................... 56 

16.1. Exporting Images ......................................................................................... 56 

16.1.1. Capture Images .................................................................................................. 56 



 Table of Contents  

4  

16.2. Exporting Statistical Results ........................................................................ 57 

17. Appendix ............................................................................................................ 58 

17.1. The BESA Statistics Data Folder ................................................................. 58 

17.2. The BESA Statistics Data Folder Information File ........................................ 58 

17.3. Group-based Data Management ................................................................. 58 

17.4. The configuration file (*.cfg) ......................................................................... 59 

17.5. How to deal with bad channels when analyzing ERP / ERF data ................. 59 

17.5.1. Interpolating bad channels in BESA Research .................................................... 59 

17.5.2. Creating a channel montage only containing good channels in BESA Research .. 59 

17.6. How to deal with re-montaged or re-referenced data ................................... 59 

18. File Formats ....................................................................................................... 60 

18.1. The BESA Statistics Time-Frequency File Format (*.tfc) ............................. 60 

18.2. The BESA Statistics Single Trial Time-Frequency File Format (*.tfcs) ......... 61 

14.1. The BESA Statistics Channel Definition File Format (*.elp) ......................... 61 

18.3. The BESA Statistics Solution File Format (*.bsa) ........................................ 61 

18.4. The BESA Statistics Image File Format (*.dat) ............................................ 62 

18.5. The BESA Statistics Source Waveforms File Format (*.swf)........................ 64 

18.6. The BESA Statistics ERP / ERF ASCII Vectorized File Format (*.avr) ......... 64 

18.7. The BESA Statistics Connectivity File Format (*.conn) ................................ 64 

19. References ......................................................................................................... 66 

 



  Notes 

5 

1. Notes 

This user manual is a guide to the research product BESA Statistics – a stand-alone software 

program.  

The manual introduces the features, workflows, and the Main Windows and dialogs of the BESA 

Statistics software. A help function is provided within the software. Press F1 on the keyboard or select 

menu item Help → BESA Statistics Help for help. 

Before starting to work with BESA Statistics, please read this user manual carefully. 

Please report any suggestions and errors found in this manual via email to feedback@besa.de. 

BESA GmbH provides support to all customers who have purchased BESA Statistics directly from our 

sales office (sales@besa.de) or through our distributors. 

BESA GmbH 

Freihamer Str. 18 

82166 Graefelfing - Germany 

In case of support requests please contact us at http://www.besa.de/contact/support/. 

 

Symbols 

 

This symbol indicates potential risks for users of BESA Statistics or third 

parties if the product is not used as intended. 

2. Intended Use 

• BESA Statistics 2.1 is intended for the following use:  

o (a) to find reliable differences between EEG / MEG data of two or more groups / 
conditions, and  

o (b) to look for reliable correlations between EEG / MEG data and an external factor 
using a cluster-permutation approach.  

• It is not allowed to use BESA Statistics 2.1 directly or indirectly for medical diagnosis and/or 
treatment of humans. BESA GmbH is not liable for the use of the software beyond the 
intended research purpose.  

• BESA Statistics software is licensed for research use only. 

• BESA Statistics 2.1 is not for commercial use e.g. fee based analysis services.  

• BESA Statistics 2.1 is not to be used beyond the scope of the intended use. 

3. System Requirements 

BESA Statistics 2.1 is a stand-alone SW product compatible with personal computers running under 

the following hardware/OS: 

mailto:feedback@besa.de
mailto:sales@besa.de
http://www.besa.de/contact/support/
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• Operating system: Windows® 11 64bit   

• CPU:   minimum 2 GHz 

• RAM:   minimum 8 GB 

• Display resolution:  minimum Full HD 1920x1080 pixels  

• Graphics card: OpenGL 3.3 with 128 MB RAM or more 

4. Disposal Information 

When disposing of the BESA license key and the box, national guidelines on environmental protection 

must be followed. 

5. Installation and Initial Setup 

The installation and initial setup of BESA Statistics must be carried out by an administrator or an 

experienced technician. 

5.1. Before Setup 

 

5.2. Installation 

1. Please download BESA Statistics 2.1 from our website, https://www.besa.de/downloads/besa-

statistics/ 

2. Run BESA_Statistics_2.1_<Month-Year>_Setup_Win_x64.exe 

3. Please follow the on-screen instructions. 

4. Once the installation is complete, proceed with the initial setup as explained in the following 
chapter. 

5.3. Initial setup  

The following section explains the steps for the initial setup of BESA Statistics. These steps have to be 

performed only once per installation.  

5.3.1. Connect the BESA License key  

BESA Statistics is protected by a licensing scheme developed by Thales. During the Installation the 

device drivers for the BESA license keys will be installed automatically.  

Connect the BESA license key to your personal computer or a server machine and proceed with the 

next step. If required, check for correct installation as described below.  

If the license key is installed correctly, the Windows 
Device Manager reports three items in the “Universal 
Serial Bus controllers” section: Sentinel HASP Key, 
Sentinel HL Key, and Sentinel USB Key. 

 

BESA Statistics is available as 64-bit program. Please make sure your Windows system 
supports 64-bit architecture prior to the installation. The installation and initial setup of BESA 
Statistics must be carried out by an administrator or experienced technical staff. 

https://www.besa.de/downloads/besa-statistics/
https://www.besa.de/downloads/besa-statistics/
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The Thales HASP key installer includes the HASP License Manager application.  

When this application is running, you should be able to load the Sentinel Admin Control Center by 
typing http://localhost:1947 in your internet browser. The connected license key should be displayed 
there. If you do not see the license key, please wait a few seconds. 

 

 

 

If the license key is not installed correctly, one of the following message boxes is displayed when the 
program is started. 

  

The message box on the left can appear for one of the following reasons: 

• The BESA license key is not connected.  

 Solution: Ensure that the key is accessible in order to run the program. 

• USB port is defective.  

Solution: Check if the LED is lit on the HASP Protection Key. If not, remove and re-insert. Wait 
for the operating system to detect the device. If it still does not light up, try another USB port.  

• Faulty license key.  

Solution: On rare occasions, the HASP Protection Keys may be faulty. The license key does not 
light up in this case and is not detected in the Device Manager. Request a replacement license 
key. 

http://localhost:1947/
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The above right message box comes up for one of the following reasons: 

• The license manager application that usually resides in C:\Program Files (x86)\Common 
Files\Aladdin Shared\HASP\hasplms.exe is blocked by a firewall or an anti-virus application. 

Solution: Add C:\Program Files (x86)\Common Files\Aladdin Shared\HASP\hasplms.exe in 
the exception list of the anti-virus and firewall applications. 

• Port 1947 is blocked by a firewall application. 

Solution: Add port 1947 to the exception list of the firewall application. 

• HASP License Manager Service is stopped. 

Solution: Restart the Sentinel HASP License Manager Service (Control Panel\System and 
Security\Administrative Tools → Services) 

5.3.2. Start the Program  

 

Start BESA Statistics using the shortcut created on the desktop or run BESA 

Statistics.exe from the Start → BESA → Statistics 2.1 folder in Startup 

menu. 

First, the Welcome Screen (11.1.1) appears. Press Accept to start BESA 

Statistics. 

5.3.3. Specify the BESA Statistics Data Folder 

As initial configuration step, the BESA Statistics Data Folder must be specified (for details see User 

Manual chapter How to use BESA Statistics). This is the folder where BESA Statistics stores all 

project and result data to and reads from. 

When starting the program for the first time, the following dialog box appears:  

 

• The BESA Statistics Data Folder is preselected to Public Users on the local PC (shown above 

for Windows 10). 

• Press the OK button if you want to use the preselected local folder in All Users.  

• Press the Edit button to create your BESA Statistics Data Folder elsewhere, e.g. on a server. 

When the selection is accepted, the following confirmation dialog appears: 
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• Press the OK button. 

BESA Statistics is now configured to start projects. 

5.3.3.1. Notes 

1. The procedure to define the shared BESA Statistics Data folder on the server needs to be carried 

out only once at each PC where you install BESA Statistics, i.e. when starting the program for the 

first time.  

2. When switching between BESA Statistics Data folders, it is recommended to leave the tick mark 

on to update all existing projects in the new BESA Statistics Data folder. 
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6. Introduction 

6.1. Features of BESA Statistics 

BESA Statistics provides optimized, user-guided workflows for cross-subject analysis of EEG / MEG 

data. The statistical method used is parameter-free permutation testing on the basis of t-Tests, F-tests 

(ANOVA / ANCOVA), or correlations. The program is maximally user-friendly. All analyses are 

computed automatically with required user-interaction reduced to a minimum. Statistical values 

computed in BESA Statistics can be directly used for scientific reports. No further analysis in other 

programs is needed. All results are visualized and can be directly used for publications. 

BESA Statistics integrates optimally with data that were analyzed in BESA Research, but it can also 

process data from other software packages as long as they conform to the BESA Statistics file format. 

The native format of the BrainVision Analyzer 2 software is also supported. 

BESA Statistics will automatically identify clusters in time, and if applicable frequency and space 

where data of the input groups / conditions are not interchangeable, i.e. where the null-hypothesis that 

all groups / conditions are equal must be rejected. Results are considered corrected for multiple 

comparisons as only those clusters will be identified that have higher cluster values than 95% of all 

clusters derived by random permutation of data (7.2). Thus, results obtained by BESA Statistics are 

objective and robust. 

There are four worksteps (five worksteps for ANOVA / ANCOVA) in BESA Statistics: 

1. Selecting the statistical test and starting a project (see 11.2.2) 

• t-Test 

• ANOVA / ANCOVA (F-test) 

• Correlation  

2. Loading data and selection of data type (see 11.2.3) 

• ERP / ERF data 

• Source waveforms 

• Time-frequency data 

• Coherence values 

• (Inter-trial) phase-locking values 

• Image data 

• Connectivity data 

3. Preliminary parametric statistics (see 11.2.7) 

An initial parametric test according to the choice made in the first workstep will be computed to 
retrieve a preliminary statistical comparison between groups / conditions, or a correlation 
between a covariate of interest and EEG / MEG data. The preliminary results are used for 
cluster-building and subsequent permutation testing. At this step, it is possible to define time-
windows and / or frequency windows of interest that will be passed on to permutation testing. 
The methods used for preliminary parametric testing is described in chapter 7.1. 

4. Non-parametric Permutation testing (11.2.8) 

A permutation test will run on the time and / or frequency period as defined in the workstep 3). 
The generated results will show clusters in time, frequency and / or space where the null-
hypothesis that assumes equality or exchangeability of all groups / conditions is rejected, i.e. 
where groups / conditions are not exchangeable and thus significantly different from each 

other. The non-parametric permutation test is described in more detail in chapter 7.2.  

5. Non-parametric Post-Hoc testing (for ANOVA / ANCOVA only, 11.2.9) 
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If an ANOVA / ANCOVA was used as the input for permutation testing, a post-hoc Scheffe’s 
test will be computed to determine, which pairwise comparison(s) were responsible for the 
group / condition main effect. Post-hoc testing is described in detail in chapter 7.3. 

7. Statistical Methods 

7.1. Preliminary Tests and Subsequent Permutation 

BESA Statistics offers three statistical tests for analyzing EEG / MEG data. A t-Test is applicable if the 

exchangeability of two groups / conditions is to be tested (7.1.1). If the exchangeability of more than 

two groups / conditions is to be tested, a one-way ANOVA (F-test) can be chosen (7.1.2). If the 

relationship between a continuous factor (e.g. cortisol level) and EEG / MEG data is of interest, BESA 

Statistics offers a correlation workflow (7.1.3). These tests are considered preliminary in BESA 

Statistics, as they are calculated sample-wise and are subject to a multiple comparisons error, i.e. they 

can wrongly suggest significance. Therefore, BESA statistics runs a permutation test on data clusters 

derived from the preliminary test statistic. The resulting parameter-free permutation statistics are 

robust and not subject to the multiple comparisons problem. The following chapters describe the 

preliminary statistical tests as well as the permutation test in more detail. 

7.1.1. Preliminary t-Test - parametric 

Student’s t-Test (Hays 1988) is computed to determine whether there is a significant difference 

between the mean of two groups / conditions. A t-Test is associated with a t-value and a 

corresponding p-value which indicates the significance of an effect. P-values smaller than 0.05 are 

generally considered significant. The p-value becomes smaller if the t-value becomes larger. t-values 

are influenced by the size of the difference between the group / condition means and the size of the 

variance in both groups / conditions. Generally speaking, the difference between two group / condition 

means can be small for the test to become significant if the variance in both groups is also small. On 

the other hand, a large difference between two group / condition means does not automatically imply a 

significant effect. It is also required that the variance in both groups / conditions is not too large. Apart 

from the t-value, the p-value is influenced by the degrees of freedom (DF) for the specific test 

computed. DF are dependent on the number of subjects. The more subjects constitute the groups / 

conditions, the larger the DF. Larger DF are more likely to be associated with a significant test result, 

as variance can be estimated more precisely with a larger number of subjects. 

A t-Test can be paired or unpaired. A paired t-Test is appropriate when there is an interdependency 

between the two conditions that are compared. This is generally the case if two conditions in the same 

set of subjects are compared (e.g. subjects listening to high intensity vs. low intensity tones) or if the 

same subject is measured twice for the same task (e.g. listening to 1000 Hz tones before and after a 

training period). An unpaired t-Test is appropriate when there is no interdependency between the two 

groups that are being compared. This is generally the case if two different groups of subjects are 

compared for the same condition (e.g. motor response in left-handed subjects vs. right-handed 

subjects). The selection of the correct type of t-Test is important: in a paired t-Test smaller differences 

between conditions are necessary for the test to become significant in comparison to an unpaired t-

Test. 

Generally speaking, the likelihood of obtaining significant results is higher if a specific hypothesis 

about the data is tested. When there is no specific hypothesis as to whether one group / condition has 

higher or lower values than the other group /condition, a two-tailed t-Test should be selected. When 

there is the hypothesis that the first group / condition has higher values than the second group / 

condition, a one-tailed-right t-Test should be calculated. When there is the hypothesis that the second 

group /condition has higher values than the first group / condition, a one-tailed-left t-Test should be 

calculated. 
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7.1.2. Preliminary One-Way Analysis of (Co)Variance (ANOVA / ANCOVA) – 
parametric (F-test) 

7.1.2.1. ANOVA 

A one-way analysis of variance ANOVA investigates the influence of an independent variable with two 

or more factor levels on a dependent variable. The null-hypothesis assumes that the means of all 

groups / conditions are equal. It gets rejected as soon as there are at least two groups / conditions 

with significantly different means, i.e. it is not required that all groups / conditions must differ from each 

other. An ANOVA is associated with an F-value and a corresponding p-value indicating the 

significance of an effect. As outlined in the previous chapter (7.1.1) p-values smaller than 0.05 are 

generally considered significant. The p-value becomes smaller if the F-value becomes larger. F-values 

are influenced by the size of the difference between the group / condition means and the size of the 

variance in the groups / conditions and the degrees of freedom. For more details on ANOVAs, see 

(Bortz 2005). 

ANOVAs can be computed between-group or within-group (repeated measures). Between-group 

means that there is no interdependency between the factor levels of the independent variable. This is 

usually the case if different groups are compared, i.e. groups of subjects from different populations. 

For example, it might be a research question whether the P300 amplitude is significantly different 

between control subjects, depressed patients and anxiety patients. As different subjects populate the 

groups, they are considered independent. Within-group (repeated measures) means that there is a 

relationship between the factor levels of the independent variable. This is usually the case if different 

conditions within the same set of subjects are compared. For example, the N100 amplitude might 

differ when the same set of subjects listen to 100dB, 80dB, and 60dB versions of the same sound. An 

alternative scenario for a within-group (repeated measures) ANOVA is that the dependent variable is 

investigated in the same set of subjects more than once, e.g. one week before a treatment, 

immediately after a treatment and at one-month follow-up. Therefore, BESA Statistics considers the 

independent variable to be “Group” for between-group analyses and “Condition” for within-group 

analyses. 

7.1.2.2. Preliminary One-Way Analysis of Covariance (ANCOVA) - parametric 

It is possible to add a covariate of no interest in the one-way ANOVA computation altering it to a one-

way analysis of covariance (ANCOVA). “Covariate of no interest” denotes a factor that might influence 

the dependent variable in its own right, thus interacting with the independent variable of interest in an 

unwanted fashion. By computing an ANCOVA, the dependent variable is corrected for the influence of 

the covariate of no interest. It is required that the covariate of no interest correlates with the dependent 

variable, that the direction of the correlation is the same in all factor levels of the independent variable 

and also that the factor levels of the independent variable should not differ significantly in the covariate 

of no interest (see important note below). 

A covariate of no interest must have numerical values (e.g. 5.9, 4.2, etc.), it cannot be categorical (e.g. 

male, female). One value must be present per subject. Here is an example for a between-group 

ANCOVA: A research question might be, whether the error-related negativity (ERN) component is 

different in control subjects, depressed patients and patients with anxiety disorder. It is suspected that 

the cortisol blood level can also influence the ERN. As the main question refers to group differences 

and not the influence of cortisol on the ERN, “cortisol level” is considered a covariate of no interest. 

Thus, it is entered in the ANCOVA for each group to correct the ERN data for the influence of cortisol 

level. If there is no dependency between the influence of blood cortisol level and the influence of the 

independent variable (e.g. group status) on ERN amplitude, a potential group main effect for ERN 

amplitude will become more significant after controlling for the covariate of no interest. 

It is also possible to run a within-group (repeated measures) ANCOVA: For example, it might be of 

interest, if the ERN is influenced by an error monitoring training. Thus, anxiety patients were tested 1 

week before the training, immediately after the training and at one-month follow-up. “Cortisol level” is 

the covariate of no interest as it might change from measurement to measurement and have an 
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unwanted influence on the ERN. Thus, cortisol levels for each measurement are entered in the 

ANCOVA. 

Important note: 

If groups / conditions differ significantly in the covariate of no interest (this can be checked by an 

independent ANOVA), results of the ANCOVA must be interpreted with caution as there is a 

systematic relationship between the independent variable and the covariate of no interest. Let us 

revisit the between-group ANOVA example from above and assume that there was a significant 

difference in ERN amplitude between control subjects and patients with depression and patients with 

anxiety. At the same time, the three groups differ significantly in their blood cortisol level. When 

entering cortisol level in the ANCOVA to control for the influence of blood cortisol levels, the ERN 

group-effect becomes non-significant. The conclusion that after “controlling for” blood cortisol level the 

groups do not differ in ERN amplitude is wrong. It is very likely that blood cortisol level is a descriptor 

of the three patient groups, e.g. a low blood cortisol level is likely to predict that a person is a control 

subject, whereas a high cortisol level likely predicts that a subject is a patient with depression. Taking 

out the effect of cortisol blood level in the ANCOVA – in this scenario – means that an important factor 

that predicts the affiliation with the three group factors (independent variables) gets eliminated. The 

correct interpretation would be that the groups do differ in ERN amplitude, but that this effect is likely 

to be related to differing blood cortisol levels, which are inherently related to group status. If however 

the group difference in ERN amplitude remains intact even after using blood cortisol level as covariate 

of no interest, it is a very strong argument that it is indeed the independent variable (i.e. group 

membership) that is associated with different ERN amplitudes. ERN amplitude does not seem to be 

influenced by cortisol levels, despite the groups differing significantly in this factor. For a very good 

discussion on ANCOVA analyses and their interpretations see (Miller and Chapman 2001). 

7.1.2.3. Post-Hoc Testing 

When a main effect in a one-way ANOVA / ANCOVA with more than two groups / conditions becomes 

significant, it is not clear, which groups / conditions differ from each other. As described in chapter 

7.1.2, it is sufficient that at least two groups / conditions differ from each other for the F-test to become 

significant. In order to find out, which / groups conditions are responsible for the main effect, post hoc 

testing needs to be performed. In principle, post-hoc testing could be done with t-Tests for all available 

group / condition pairings. This is not recommended, however, as a t-Test would over-estimate the 

statistical significance of mean differences as it does not take into account that more than two sample 

sets were drawn from the population in the original F-test. This can lead to data clusters outside the 

cluster boundaries originally identified with the F-test. In order to prevent this from happening, BESA 

Statistics uses Scheffe’s test (Winer, Brown et al. 1991) for post-hoc testing. It specifically takes into 

account that more than two sample sets were drawn from the population and guarantees that no 

clusters can appear outside the boundaries set by the F-test. The application of Scheffe’s test in the 

permutation setting is described in chapter 7.3. 

7.1.3. Preliminary Correlation 

In contrast to the ANCOVA, where the influence of a covariate on the dependent variable is unwanted 

and of no interest, the opposite is the case for correlation. Correlation analysis investigates the 

relationship between two variables. It is dependent on the covariance of the two variables, i.e. the 

estimate of how much the two variables are changing together, the standard deviation of the two 

variables and the degrees of freedom. Correlation analysis yields an r-value that can be positive or 

negative, and associated t-values and p-values. An r-value of 1 means that there is a perfect positive 

relationship between the two variables. The direction of the relationship is the same, i.e. if values in 

one variable increase, values in the other variable also increase. An r-value of -1 means that there is a 

perfect negative relationship between the two variables. If the values in one variable increase, the 

values in the other variable decrease. An r-value of 0 means that there is no relationship at all. 
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Besides the r-value it is also possible to depict the relationship of the two variables with a regression 

line. For more details on correlation analysis see (Pearson 1896). 

A covariate of no interest must have numerical values (e.g. 5.9, 4.2, etc.), it cannot be categorical (e.g. 

male, female). One value must be present per subject. As an example, it might be of interest, if there 

is a relationship between a subject’s cortisol blood level and the ERN component in the EEG. A 

positive correlation would indicate that higher cortisol levels are associated with higher ERNs. A 

negative correlation would indicate that higher cortisol levels are associated with lower ERNs and vice 

versa. 

7.2. Permutation Test (non-parametric) 

When computing a large number of tests, the probability of obtaining a significant result by chance is 

high. Typically, an α-error of 5% (p-value = 0.05) is assumed when calculating statistical tests. Thus, if 

a significant result is achieved, there is a 5% chance that this result is considered significant although 

in truth it is not. The more tests are computed, the higher the probability that some statistically 

significant results are obtained by chance. 

Statistically analyzing EEG / MEG data usually involves computing a large number of tests, as two or 

more conditions are compared for a large number of electrodes / sensors over a time interval 

containing many data samples. Therefore, the multiple comparisons problem is particularly prominent 

when running statistics on EEG / MEG data. 

There are different ways to address the multiple comparisons problem. The easiest is to apply the 

Bonferroni correction (Abdi 2007), where the significance level (e.g. p = 0.05) is divided by the number 

of tests computed and only those tests are assumed to be significant with p-values smaller than the 

corrected value. For example, if 100 tests are computed, the corrected p-value would be 0.05 / 100 = 

0.0005. This approach is very conservative and the chance is high that significant results are 

wrongfully rejected. Bonferroni correction treats all data samples as independent, which is not a 

correct assumption in the case of EEG / MEG data. 

BESA Statistics uses an alternative approach to deal with the multiple comparisons problem: data 

clustering in combination with permutation testing. The main idea is that if a statistical effect is found 

over an extended time period in several neighboring channels, it is unlikely that this effect occurred by 

chance. Thus, the initial step is to define data clusters that show pronounced effects in the preliminary 

parametric tests. For each cluster, a cluster value can be derived consisting of the sum of all t-values / 

F-values of all data points in the cluster. 

 
Figure 8.2a Example for how a cluster value is derived. 
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For t-Test and correlation (not for ANOVA / ANCOVA), a statistical effect can have a direction (i.e. 

condition 1 can have larger or smaller values than condition 2 or the correlation can be positive or 

negative), positive and negative clusters can be found, i.e. the cluster values can also be positive 

or negative. The initial clustering based on the preliminary parametric tests is followed by permutation 

of the data. 

The null-hypothesis behind any kind of permutation test is the exchangeability of data (see 

also: http://www.fieldtriptoolbox.org/faq/how_not_to_interpret_results_from_a_cluster-

based_permutation_test). For t-Test and ANOVA / ANCOVA, the null-hypothesis assumes that the 

data of the input groups / conditions are exchangeable. For correlation it is assumed that the 

assignment of the covariate per person is random and exchangeable. In other words, the null-

hypothesis in permutation testing assumes that the initial cluster values derived by the preliminary 

parametric test in the recorded data are equally likely as any other cluster values derived in each 

permutation step. 

Permutation means that the data of subjects (for unpaired t-Tests, between-group ANOVA / 

ANCOVAs and correlations) or conditions (for paired t-Tests or within-group ANOVA / ANCOVAs) get 

systematically interchanged.  

 
Figure 8.2b Example for how data are exchanged during permutation testing when a paired t-Test is used as the 
input test. 

Depending on the number of subjects per group / condition and the type of test, a certain number of 

permutations are possible. The following example is for t-Tests: If two conditions are compared in 10 

subjects using a paired t-Test, 1024 (2n, where n is the number of subjects) permutations are possible. 

If 10 subjects are compared with another set of 10 subjects for the same condition using an unpaired t-

Test, 184756 ((n+k
k
), where n is the number of subjects in the larger group, and k is the number of 

subjects of the smaller group; please note that in this example, the groups are the same size!) 

permutations are possible. For each of the calculated permutations (default: 10001), a new t- test is 

computed per data-point. For each permutation, new clusters are determined and the according 

cluster values are derived for each cluster. Thus, a distribution of cluster-values can be established 

across all permutations. Based on this new distribution, the α-error of the initial cluster value can be 

directly determined. For example, if only 2% of all cluster values are larger than the initial cluster 

value, the initial cluster has a 2% chance that the null-hypothesis was falsely rejected, i.e. the data of 

groups / conditions are considered un-exchangeable although in truth they are exchangeable. 

Conversely, the data of groups / conditions are not interchangeable with a chance of 98%. Therefore, 

 
1 Drawn randomly without repetitions from all possible permutations. If there are not enough subjects to select 
1000 permutations, the number is automatically adjusted to the maximum possible number of permutations. 

http://www.fieldtriptoolbox.org/faq/how_not_to_interpret_results_from_a_cluster-based_permutation_test
http://www.fieldtriptoolbox.org/faq/how_not_to_interpret_results_from_a_cluster-based_permutation_test
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the cluster is associated with the p-value 0.02 (one-sided test). Thus, based on the computed cluster-

value distribution, the probability of each initial cluster can be directly determined (see Figure 8.2c). 

The same permutation logic as for the above t-Test example also applies for F-tests (ANOVA / 

ANCOVAs) and correlations. As the preliminary test is only used for clustering, the type of input test 

does not matter. Depending on experimental design, it is still important to pick the appropriate 

preliminary test. 

 

Figure 8.2c A realistic distribution of cluster values based on 1000 permutations is displayed. The figure indicates 
that a cluster value of 300 is associated with a probability value of p=0.05 (one-sided t-Test), meaning that only 
5% of all clusters have absolute values larger than 300. 

Since in permutation testing the distribution of cluster values is computed from the input data, and 

probability values are derived directly from the computed distribution, permutation testing is 

considered non-parametric, or parameter-free. This is a great advantage, since it is not required that 

data are normally distributed, as would be the case if classic parametric tests were used. 

For more details on the implementation of the permutation test as implemented in BESA Statistics 

please refer to the following publications: (Bullmore, Suckling et al. 1999; Maris and Oostenveld 2007; 

Ernst 2004). For permutation testing in the case of correlation, see (Freedman and Lane 1983; 

O’Gorman 2012). 

Important Note on the Interpretation of Clusters:  

The size of a cluster depends on various factors. On the one hand it is directly influenced by the 

cluster alpha value (see 11.2.7.2.) on the other hand it depends on factors such as signal to noise 

ratio, recording modality, and analysis type. Particular caution is advised when interpreting clusters 

that were derived from sensor space data. For example, sources in the auditory cortex will lead to 

dipolar fields over temporal areas with a positive and a negative pole in MEG and a fronto-central 

negativity in EEG. In the MEG case, it would not make sense to interpret two clusters, one in the 

positive and one in the negative pole of the same dipolar field separately, as they both reflect the 

same underlying activity, i.e. the auditory cortex source. In the EEG case, it does not make sense to 

interpret the extent of a cluster in fronto-central sensors as again the extremely wide-spread fronto-

central activity reflects potentially very focal activity in auditory cortex that is subject to the poor 

conductivity of the skull resulting in a widely distributed field potential. In the case of image data, i.e. 

results from distributed source analysis like LORETA, the extent of a cluster should also be interpreted 

with caution as the extent of the activity is extremely dependent on the input method. For example, an 

iterative approach will lead to less wide-spread activity and in consequence clusters compared to non-

iterative methods, although they reflect the same underlying activity. Regarding the extent of a cluster 
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in time, it should be taken into consideration that the temporal extent of an event-related potential / 

field is dependent on other factors besides the underlying activity in a cortical patch. For example, a 

brain response can be more or less time-locked to a stimulus, leading to very sharp (highly time-

locked) or more wide-spread (more jitter) ERPs / ERFs, although the underlying activity might in fact 

be the same. Likewise, identifying two clusters in the same ERP / ERF or source waveform cannot 

necessarily be interpreted as two separate activities. They might well reflect the same underlying brain 

activity. 

7.3. Post-Hoc Permutation Test (non-parametric) – Scheffe’s Test 

As mentioned in chapter 7.1.2.3, it is necessary to run a post-hoc test when a main effect in a one-way 

ANOVA / ANCOVA with more than two groups / conditions becomes significant. BESA Statistics uses 

Scheffe’s test for this purpose. Scheffe’s test computes F-values for all pairwise comparisons of 

groups / conditions and determines a new critical F-value indicating, which individual pairwise 

comparisons of groups / conditions are significant (for more details about Scheffe’s test theory see 

(Bortz 2005). In our case, this yields new clusters that will always be sub-sets of the ANOVA / 

ANCOVA clusters. As each permutation is associated with different clusters, and in consequence 

different cluster F-values, Scheffe’s test must also be computed for each permutation. A new 

distribution of Scheffe’s test F-values is built and p-values are derived directly from the computed 

distribution as described in chapter 7.2. 

As Scheffe’s test runs pairwise comparisons, the permutation test based on Scheffe’s F-values is 

repeated several times (n
2
). As an example, if 3 groups / conditions are compared, 3 permutation tests 

need to be computed ((group / cond. 1 vs group / cond. 2), (group / cond. 2 vs group / cond. 3), (group 

/ cond. 2 vs group / cond. 3)). In the case of 4 groups / conditions, 6 permutation tests must be run. 

Thus, we are yet again faced with a multiple comparison problem. In order to correct for this, BESA 

Statistics uses the Bonferroni Holm method. It is less conservative than the Bonferroni correction, but 

less liberal than using no correction at all. 

The following example delineates the application of the Bonferroni-Holm correction in a cluster-

permutation setting. Let us assume we ran Scheffe’s test in 3 groups, and that the following cluster 

structure was revealed for the individual pairwise comparisons: 

Group 1 vs. Group 2 Group 1 vs. Group 3 Group 2 vs. Group 3 

   

   

p=0.01 

   

   

  

p=0.02 

  

  

p=0.04 

  

 

p=0.02 

   

  

p=0.03 

 

p=0.07– n.s. 

 

p=0.08 

  

Figure 8.3a Clusters for pair-wise comparisons as derived by Scheffe’s test before Bonferroni-Holm correction 

The first step of the Bonferroni-Holm method is to calculate the corrected p-value following 

Bonferroni. As we are running 3 pairwise comparisons, we need to divide our p-value by 3: 0.05 / 3 ≈ 
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0.0167. We then identify the pairwise test that contains the cluster with the smallest p-value, in the 

present example it is the comparison Group 1 vs. Group 2. We determine, if this comparison contains 

a cluster that survives the Bonferroni correction. In the above example, the first cluster (with 6 boxes) 

does (0.01 < 0.0167, see fig. 8.3b). The other two clusters within this pairwise comparison do not 

survive the Bonferroni correction and must be discarded. 

Group 1 vs. Group 2 Group 1 vs. Group 3 Group 2 vs. Group 3 

   

   

p=0.01 

   

   

  

p=0.02 

  

  

p=0.04 

  

 

p=0.02 – n.s. 

   

  

p=0.03 

 

p=0.07 

 

p=0.08 – n.s. 

  

Figure 8.3b Step 1 of Bonferroni-Holm correction 

The second step of the Bonferroni-Holm method takes into account that the first comparison 

contained at least one cluster that survived Bonferroni correction. Therefore, the p-value is not divided 

by 3 anymore, but only by 2 (3 minus 1): 0.05 / 2 = 0.025. Then we identify the pairwise test with the 

second-most significant cluster: in the above example this is the comparison Group 1 vs. Group 3. 

We determine, if this comparison contains a cluster that survives the adjusted Bonferroni correction (p-

value 0.025). In the present example, the first cluster (with 8 boxes) does (0.02 < 0.025, see fig. 8.3c). 

The other cluster does not survive the Bonferroni correction. 

Group 1 vs. Group 2 Group 1 vs. Group 3 Group 2 vs. Group 3 

   

   

p=0.01 

   

   

  

p=0.02 

  

  

p=0.04 

  

 

p=0.02 – n.s. 

   

  

p=0.03 – n.s. 

 

p=0.07 

 

p=0.08 – n.s. 

  

Figure 8.3c Step 2 of Bonferroni-Holm correction 

The third and final step of the Bonferroni-Holm method in the present example takes into account 

that two comparisons contained at least one cluster that survived the (adjusted) Bonferroni correction. 
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Therefore, the p-value is not divided by 3 anymore, but only by 1 (3 minus 2): 0.05 / 1 = 0.05. Then we 

check, if our last pairwise test contains clusters with an associated p-value < p=0.05. In the present 

example, this applies to the first cluster (with 2 boxes) (see fig. 8.3d). The other cluster must be 

discarded. 

Group 1 vs. Group 2 Group 1 vs. Group 3 Group 2 vs. Group 3 

   

   

p=0.01 

   

   

  

p=0.02 

  

  

p=0.04 

  

 

p=0.02 – n.s. 

   

  

p=0.03 – n.s. 

 

p=0.07 – n.s. 

 

p=0.08 – n.s. 

  

Figure 8.3d Step 3 of Bonferroni-Holm correction 

The above example demonstrates that the Bonferroni-Holm correction reduced the number of clusters 

as derived by the permutation test based on Scheffe’s test. While the first pairwise test (Group 1 vs. 

Group 2) originally yielded 3 clusters, now only 1 cluster remains. The second pairwise-test (Group 1 

vs. Group 3) originally yielded 2 clusters: however, after the Bonferroni-Holm correction only 1 cluster 

remains. In the third pairwise-test (Group 2 vs. Group 3), only the first cluster remains. This example 

also shows that the Bonferroni-Holm method is less conservative than the Bonferroni correction, as 

this would only have yielded one cluster in the first pairwise comparison. 
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8. The Workflow Concept 

BESA Statistics uses a modern workflow concept that guides you through all the worksteps needed to 

complete a project, suggests and explains necessary inputs and user actions, and performs many 

worksteps automatically. At any time, you may interrupt and inspect earlier worksteps or redo them 

with modified input parameters if required. 

  

A workflow consists of a series of worksteps required to finalize a project. Each workstep contains a 

set of user interactions needed to achieve the workstep-specific result. Only few user interactions are 

needed.  

When pressing the Next button or Space, a workstep is completed and the next workstep is loaded. 

Thus, the workflow of a project sequentially proceeds from workstep to workstep. 

The layout of the BESA Statistics screen is optimized for this workflow concept. The workflow menu - 

as shown on the left in the Workflow Window - gives an overview over all the worksteps to be 

completed in the selected project (see 9.1). The workflow menu can be used to switch between the 

worksteps. For example, you may redo an earlier step with different or advanced parameters and 

continue with automatic processing of all subsequent steps as defined before. 

The current results during a workstep are shown in the Main Window in the center of the screen (see 

9.2). The Information Window below (see 9.4) provides advice and help information for the current 

workstep. 

During each workstep a specific dialog is shown in the Interaction Window on the right to allow for 

optimized user interaction relevant for the current workstep (see 9.3). After completing all interactions, 

press the Next button at the bottom or Space to proceed to the next workstep. Press the Previous 

button to go back one workstep. After completing the last workstep of the workflow, press the Finish 

button at the bottom of the Interaction Window to save all data created during the project. This saving 

step enables reloading the full workflow of a project with all worksteps at a later time. 
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A project is defined by a specific workflow together with the stored individual input and output data. 

Stored projects can be viewed by selecting the menu item File → Open Project, by using the open 

button in the toolbar, or by pressing the Open Project buttons on the start screen. After opening a 

stored completed project, the final workflow result is displayed. 

9. Elements of the BESA Statistics Screen 

The layout of BESA Statistics screen is optimized for the workflow concept as described in chapter 8. 

The figure below shows the BESA Statistics screen with all its elements: 

 

9.1. Workflow Window 

The Workflow Window on the left displays the workflow menu. The workflow menu gives an overview 

over the sequential steps needed to finish the current project. Steps already completed are marked 

with a green OK sign ( ). 

The current workstep is highlighted. This step is also shown in the caption. 

The workflow menu can be used like any other menu to jump to another workstep provided that the 

previous worksteps have already been completed. 

9.2. Main Window 

The Main Window area displays the results of the current workstep. A detailed description how to use 

the elements shown in this window is given in chapter 11.2.7. 

9.3. Interaction Window 

The Interaction Window provides the user interaction for the current workstep. 

The upper interaction elements are used to set parameters needed in the workstep by using standard 
elements like buttons, edit boxes, and sliders. The effect of changing parameters is seen in the Main 
Window left of the Interaction Window. 

 

1. Workflow Window (9.1) 

2. Main Window (9.2) 

3. Information Window (9.4) 

4. Interaction Window (9.3) 

5. Title bar (10.2) 

6. Menu bar (10.1) 

7. Caption (10.4) 

8. Tool bar (10.3) 
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In some worksteps, additional interaction elements are shown at the bottom of the Interaction Window 
to enable changing visualization parameters. 

Current parameters are accepted by typing Space, or by pressing the Next button at the bottom 
prompting the workflow to proceed to the next workstep. 

The Previous button is used to jump back to the previous workstep. 

9.3.1. Notes  

• You can also undo or redo a workstep using the menu items Edit → Undo and Edit → Redo or 
by typing Ctrl-Z or Ctrl-Y. 

• Moving on to the next workstep is fastest by typing Space or Enter. 

9.4. Information Window  

The information window displays a comprehensive help text related to the current workstep. The help 
texts provide additional information, e.g. which file has been loaded. They suggest and explain the 
next user interaction to be done in the current workstep. 

Underlined text in blue provides a hyperlink. Click on such a link to open the BESA Statistics help at 

the indicated topic. 

 

10. Program Bars 

10.1. Menu Bar 

The Menu Bar provides the menus listed below. Click on a menu to select and choose from the menu 
items that pop up. 

10.1.1. File Menu 

The File menu contains the following items: 

File menu item Description 

Create New Project Start a new project. 

Open Project 
Load an existing project. A choice can be made between project 
types t-Test, ANOVA, and correlation. 

Close Project Close currently active project. Show the Select Project Page. 

Save Save the currently active project. 

Save As… Specify a filename for currently active project and save it. 

Delete Projects… Select one or multiple projects that shall be. 

Select Data Folder 
Select the folder to be used as BESA Statistics Data Folder (see 
5.3.3). 

Update Data Folder Info 
Update the information file in the BESA Statistics Data Folder (see 
5.3.3). 
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Exit Terminate the BESA Statistics program. 

10.1.2. Edit Menu 

The Edit menu contains the following items: 

Edit menu item Description 

Undo Undo the last step completed in the current workstep. 

Redo Redo the last step that was undone in the current workstep. 

10.1.3. View Menu 

The View menu can be used to change display settings for BESA Statistics. It contains the following 
entries: 

View menu item Description 

Show Workflow Window 
By selecting or deselecting this menu item the Workflow Menu is 
displayed or hidden (see 9.1). 

Show Information 
Window 

By selecting or deselecting this menu item the Information Window 
is displayed or hidden (see 9.4). 

Standard Font Size, 

Large Font Size, 

Extra Large Font Size 

Select one of these menu items to specify the size of the font to be 
used in BESA Statistics. 

Settings 

→Themes 

→Sequential Colormap 

→Diverging Colormap 

 

Allows adjusting the overall color scheme for BESA Statistics 
application and color map used in 2D top view, time-frequency and 
connectivity displays – separately for the case of sequential data 
and diverging data. 

Themes: 

• BESA Standard 

• BESA White 

Sequential Colormap: 

• Standard  

• Rainbow  

• Viridis  

• White to Red  

Diverging Colormap: 

• Standard  

• Blue to Red  

10.1.4. Export Menu 

The Export menu can be used for exporting vector graphics (*.eps and *.svg) or bitmap images 
(*.png) of the main window, of the detail windows or of a combination of all windows. It also allows 
exporting the statistical results of the permutation test either as a summary (Cluster and p-values, 
cluster boundaries) or as detailed means per subject / cluster. For a more detailed description of the 
exporting options please see chapter 16. 
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Export menu item Description 

Image 

Allows exporting images of the main window, the left detail window, 
the right details window or all windows. In the saving dialogue, the 
format (*.png, *.eps, or *.svg) can be specified. Images can also be 
exported by right-clicking in the according window. 

Statistical Results 
Allows exporting the summary of cluster statistics and detailed 
results per cluster (see 16.2). Results are saved as comma-
separated values (*.csv). 

10.1.5. Help Menu 

Use the Help menu to open the program help or to get information about BESA Statistics. 

Help menu item Description 

BESA Statistics Help Open the program help. 

About… Get information about the current program version. 

10.2. Title Bar 

The title bar of BESA Statistics displays the program name and version number. In addition, it shows 

information on the current project: 

• Group name 

• Project name 

10.3. Toolbar 

The Toolbar provides direct access to the most important menu items: 

File → Create New Project 

File → Open Project 

File → Close Project 

File → Save Project 

Edit → Undo 

Edit → Redo 

10.4. Caption 

The caption is located between the Menu Bar and the Toolbar and specifies the current workstep. 
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11. How to use BESA Statistics 

Before working with BESA Statistics, please consult chapter 9 on the elements of the BESA Statistics 

screen. 

11.1. Starting BESA Statistics 

11.1.1. Welcome Screen 

Start BESA Statistics from its icon on the desktop. 

When starting BESA Statistics, a welcome screen appears. It provides some information on the BESA 

Statistics program including the current version number and date: 

 

Press Accept to start BESA Statistics. 

11.2. The Workflow of BESA Statistics 

11.2.1. The Workflow 

Three different workflows (or projects) can be chosen: t-Test, ANOVA (incl. ANCOVA), and 
Correlation. Each workflow consists of specifying the experimental design, loading EEG / MEG data, 
the calculation of a preliminary parametric test used for cluster-building and optionally further 
specification of data regions of interest, and finally the calculation of a cluster permutation test. If an 
ANOVA project is started, there is an additional workstep for post-hoc testing. The worksteps are 
described in the following chapters. 

11.2.2. Select Project – Parametric Test 

In order to start a workflow for statistical analysis, a selection of the statistical project must be made: 

• Start New t-Test Project 

• Start New ANOVA Project 

• Start New Correlation Project 

• Open Project 

For a more detailed description of the statistical tests, please see the previous chapters 7.1. 
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Notes: Projects can also be started or opened at any time by selecting the menu items File → Create 

New Project or File → Open Project. 

11.2.3. Set Project Targets: Data Type 

After selecting a statistical project, the type of data that will be analyzed needs to be specified: 

• TFC (Time-Frequency and Coherence): time-frequency analysis or coherence results in 

source space (TFC → SWF) or sensor space (TFC → ERP / ERF) 

• Image: data derived from distributed source analysis (e.g. LORETA) in a volume2 

• SWF (source waveforms): data derived from discrete source analysis using single dipoles or 

regional sources 

• ERP / ERF: event-related potential /field data (sensor-level) obtained by averaging across trials 

• Connectivity: connectivity analysis results 

The required file format of the different data types is described in chapter 18. 

After selecting the input data type, further specifications need to be made for the chosen statistical 

test. Press Start to initialize the selected workflow or return to the workflow selection with Previous. 

11.2.4. Set Project Targets for Parametric Test 

11.2.4.1. t-Test 

The type of t-Test that will be used as the base for permutation testing needs to be set (see 7.1.1): 

• Paired t-Test: In case two conditions are compared within the same subjects, a paired t-Test 

should be selected. E.g. The EEG of 10 subjects was measured while they were listening to 

tones of high and low frequency. The brain response to tones of high frequency will be 

compared to the brain response to tones of low frequency within the same 10 subjects. 

• Unpaired t-Test: In case two groups of subjects are compared for the same condition, an 

unpaired-t-Test should be selected. E.g. the EEG of a control group and a patient group is 

measured while subjects are viewing pleasant pictures. The brain response to pleasant 

pictures will be compared between control subjects and patients. 

• Two-tailed, one-tailed left, one-tailed right: Generally speaking, the likelihood to obtain 

significant results is higher if a specific hypothesis about the data is tested. In case there is no 

specific hypothesis as to whether one group/condition has higher / lower values than the other 

group/condition, a two-tailed t-Test should be selected. In case there is the hypothesis that the 

first group / condition has higher values than the second group / condition, a one-tailed-right t-

Test should be selected. In case there is the hypothesis that the second group / condition has 

higher values than the first group / condition, a one-tailed-left t-Test should be selected. 

11.2.4.2. ANOVA 

The type of ANOVA that will be used as the base for permutation testing needs to be selected (see 
7.1.2): 

• Univariate ANOVA Within-Group: In case more than two conditions are compared within the 

same subjects, a univariate within-group ANOVA should be selected. E.g. the EEG of the 

same 10 anxiety patients was measured before, directly after and 1 month after an anti-anxiety 

 
2 Please note that Minimum Norm solutions are calculated on a standard cortex in BESA Research. Statistical 
analysis of cortex-based solutions is currently not yet supported. 
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training. The research question is, which, if any, brain regions, EEG / MEG sensor 

measurements, and / or time-frequency regions are sensitive to the influence of the training. 

o With Covariate of no Interest (ANCOVA): In case there is a variable that also influences 

the dependent variable and co-varies with the independent variable in an undesired fashion, 

a covariate of no interest can be entered in the ANOVA. E.g. the blood cortisol level was 

measured per person at each of the three time-points in the above experiment, and may 

have an influence on the subject’s response value, which we have no interest in within the 

framework of our research question. Blood cortisol level can then be used as the covariate 

of no interest. 

• Univariate ANOVA Between-Group: In case one condition shall be compared between more 

than two groups of different subjects, a univariate between-group ANOVA should be selected. 

E.g. The EEG was measured in 10 control subjects, 15 patients with depression, and 12 

patients with schizophrenia while they were presented words with affective content. The 

research question is, which brain regions, EEG / MEG sensor measurements, and / or time-

frequency regions differentiate between controls, depressed and schizophrenic patients in 

emotion processing. 

o With Covariate of no Interest (ANCOVA): In case there is a variable that also influences 

the dependent variable and co-varies with the independent variable in an undesired fashion, 

a covariate of no interest can be entered in the ANOVA. E.g. the blood cortisol level was 

measured per person for each of the three groups in the above experiment, and may 

have an influence on the subject’s response value, which we have no interest in within the 

framework of our research question. Blood cortisol level is then the covariate of no interest. 

11.2.4.3. Correlation 

Correlation can be computed between data of one group / condition and one covariate of interest (see 

7.1.3). The t-value associated with the correlation coefficient will then be used as the base for 

permutation testing. For example, an MEG component in 15 subjects can be correlated with the 

results of an attention test. 

11.2.5. Define Experimental Design 

In this workstep, the experimental design must be specified further in case an ANOVA or correlation 

project was started. This step is not required for t-Test. The interaction window is sub-divided into 3 

boxes. The top box gives an overview of the selected data type and statistical test. The middle box 

includes the experimental design, the bottom box includes the factor level names.  

11.2.5.1. Within-Group ANOVA 

For Experimental Design, the following input has to be provided: 

• Number of Within-Group Factor Levels: The number of conditions that shall be compared 

within the same set of subjects is provided here. E.g. The EEG of the same 10 anxiety patients 

was measured before, directly after and 1 month after an anti-anxiety training. In this case, the 

number of factor levels is 3. 

• Number of Subjects: The number of subjects, i.e. datasets per factor level, is specified here. 

Only one number can be entered, i.e. the number of subjects must be identical for all factor 

levels / conditions and the subjects have to be the same. 

For Factor Level Names, the following input is expected: 

• Group Name: A name should be entered that describes the subjects best. E.g. the group name 

could be “Anxiety Patients”. 
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• Condition 1 through n: Names should be provided for all factor levels / conditions. E.g. 

Condition 1: “Before treatment”; Condition 2: “1 day post-treatment”; Condition 3: “1 month 

post-treatment” 

 

11.2.5.2. Within-Group ANCOVA 

The same input has to be provided as for Within-Group ANOVAs (11.2.5.1). Additionally, the following 

information is entered for Experimental Design: 

• Number of Covariates of no Interest: Currently restricted to 1. 

For Factor Level Names, the following input is expected: 

• Covariate of no Interest: A name should be provided that describes the covariate whose 

influence will be subtracted from the data. E.g. “Blood cortisol level” 

11.2.5.3. Between-Group ANOVA 

For Experimental Design, the following input has to be provided: 

• Number of Between-Group Factor Levels: The number of groups that shall be compared for 

the same dependent variable is provided here. E.g. The EEG of anxiety patients, depressed 

patients and control subjects was measured while reading emotionally charged words. In this 

case, the number of factor levels is 3. 

• Number of Subjects per Group: The number of subjects per group, i.e. datasets per factor 

level, is specified here. The number of subjects can be different for all factor levels / 

conditions and the subjects cannot be the same per group. 

For Factor Level Names, the following input is expected: 

• Study Name: A name should be entered that describes the experiment best. E.g. the study 

name could be “Affective processing”. 
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• Between Group 1 through n: Names should be provided for all factor levels / groups, e.g. 

Group 1: “Depression; Group 2: “Anxiety”; Group 3: “Control”. 

11.2.5.4. Between-Group ANCOVA 

The same input has to be provided as for Between-Group ANOVAs (11.2.5.3). Additionally, the 

following information must be entered for Experimental Design: 

• Number of Covariates of no Interest: Currently restricted to 1. 

For Factor Level Names, the following input must be expected: 

• Covariate of no Interest: A name should be provided that describes the covariate whose 

influence will be subtracted from the data, e.g. “Blood cortisol level” 

11.2.5.5. Correlation 

For Experimental Design, the following input has to be provided: 

• Number of Subjects: The number of subjects, i.e. datasets, is specified here. 

For Factor Level Names, the following input is expected: 

• Covariate of Interest: A name should be provided that describes the covariate that will be used 
for the correlation analysis, e.g. “Number of correct trials” 

11.2.6. Loading Data 

It is recommended that the data that are to be analyzed by BESA Statistics are organized into 

separate folders, one folder per condition / group containing as many files as there are subjects. One 

of the data folders needs to contain 1 copy of the additional file required for ERP / ERF, TFC, SWF, 

Connectivity data (see 11.2.6.7). 

11.2.6.1. t-Test 

 

Pressing the first Load Data… button will 

bring up a file selector box. A group and a 

condition name need to be specified before 

loading the data of the first group / condition. 
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The file names will be listed in the Main 

Window along with the specified group and 

condition name. A green tick-mark will be 

displayed next to the Load Data button in 

case the data were successfully loaded. 

Type Space or press Next, or the next Load 

Data button to continue the workflow. In case 

a paired t-Test was selected previously only 

the second condition name can be entered in 

the dialogue, the group name will remain 

fixed. If an unpaired t-Test was selected 

previously only the second group name can 

be entered, the condition name will remain 

fixed. After loading all required data, the 

Loading Data workstep is complete. 

 

11.2.6.2. Loading paired t-Test data 

In case a paired t-Test project was started, data files for condition 1 will be loaded in the first step, 
and data files for condition 2 will be loaded in the second step. There needs to be one data file per 
person per condition. The number and order of files in both conditions needs to be the same (see 
12.7.a). In case an unpaired t-Test project was started, the order and the number of files do not have 
to be the same for both groups of data, but need to originate from different subjects. 

Box 12.7.a Data Organization for paired t-Tests 

11.2.6.3. ANOVA / ANCOVA 

If an ANOVA was selected, the Load Data… buttons will already be named in line with the user input 

in the previous step Design Experimental Paradigm. The number of Load Data… buttons depends 

on the number of factor levels. 

It is crucial for paired T-Tests that the same number of files is loaded for both conditions and 
that the order of the files is the same for both conditions! 

Correct            Incorrect 

Data Cond. 1 Data Cond. 2 

Subject 1 Subject 1 

Subject 2 Subject 2 

Subject 3 Subject 3 

Subject 4 Subject 4 

Subject n Subject n 
 

Data Cond. 1 Data Cond. 2 

Subject 1 Subject 3 

Subject 2 Subject 1 

Subject 3 Subject 2 

Subject 4 Subject 4 

Subject n  
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11.2.6.4. Loading within-group ANOVA data 

In case a within-group ANOVA project was started, data files for condition 1 will be loaded in the first 

step, data files for condition 2 will be loaded in the second step, and data files for condition n will be 

loaded in the nth step. There needs to be one data file per person per condition. The number and 

order of files in all conditions needs to be the same (see Box 12.7.b). In case a between-group 

ANOVA project was selected, the order and the number of files do not have to be the same for the 

different groups of data. 

It is crucial for within-group ANOVAs that the same number of files is loaded for all conditions and 
that the order of the files is the same for all conditions! 

Correct                   Incorrect 

 
Box 12.7.b Data Organization for a within-group ANOVA with 3 factor levels 

Data Cond. 
1 

Data Cond. 
2 

Data Cond. 
3 

Subject 1 Subject 1 Subject 1 

Subject 2 Subject 2 Subject 2 

Subject 3 Subject 3 Subject 3 

Subject 4 Subject 4 Subject 4 

Subject n Subject n Subject n 
 

Data Cond. 
1 

Data Cond. 
2 

Data Cond. 
3 

Subject 1 Subject 3 Subject 1 

Subject 2 Subject 1 Subject 3 

Subject 3 Subject 2 Subject 2 

Subject 4 Subject 4  

Subject n  Subject 4 
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After loading the data, the table in the 

Main Window will be filled with the file 

names. The table allows a quick check 

if the file order is correct or needs 

adjustment. 

 

In case the file order is incorrect, it is 

possible to move individual files within 

the according column by clicking on the 

file name and using the arrow buttons 

to move the content up or down. 

 

 

11.2.6.5. Loading ANCOVA data 

If an ANCOVA project was selected, additional Load Data… buttons will be present for the covariate 

of no interest. In the first step, data for the first covariate of no interest are loaded. In the second step 

data for the first factor level are loaded. In the third step data for the second covariate of no interest 

are loaded, in the fourth step data for the second factor level are loaded, etc. 

Please note that for both, within and between-group ANCOVAs there need to be separate text files 

for each factor level. The file containing the covariate of no interest needs to contain 1 column with 1 

numerical value per line, i.e. one value per person (see Box 12.7.c). If a between-group ANCOVA is to 

be computed for 3 groups, there need to be 3 text-files containing the covariate of no interest, one file 

for each group. Likewise, if a within-group ANCOVA is to be computed for 3 conditions, a separate 

text-file containing the covariate of no interest must be available for each of the 3 conditions. The 

individual files containing the covariate of no interest must have different content. As an example, if 

depressed patients, anxiety patients and control subjects are to be compared before, immediately after 

and 1 month follow up of a treatment, it is not possible to use “age (in years)” as the covariate of no 

interest, as it would be the same for all 3 factor levels. If “blood cortisol level” was measured 

separately per test time-point, it could be used as the covariate of no interest (see also the chapter on 

7.1.2.2). 



  How to use BESA Statistics 

33 

The order of the files for a factor level and the order of the entries of the text-file containing the 
covariate of no interest have to be the same (see Box 12.7.c). 

Box 12.7.c Data Organization for ANCOVAs 

After loading the data, the table in the Main Window will be filled with the file names and the entries of 

the covariate files (see 11.2.6.4). The table allows a quick check if the file order is correct, or whether it 

needs adjustment. In case the file order is incorrect, it is possible to move individual files or covariate 

entries within the according column by clicking on the file name and using the arrow buttons to move 

the content up or down (see 11.2.6.4). 

11.2.6.6. Loading Correlation Data 

If a correlation project was selected, the Load data… buttons will already be named in line with the 

user input in the previous step. In the first step data for the Covariate of Interest will be loaded, in the 

second step EEG / MEG data for all subjects will be loaded. 

The order of the files containing the EEG / MEG data and the order of the entries of the text-file 
containing the covariate of interest have to be the same (see Box 12.7.d).  

 Box 12.7.d Data Organization for Correlation 

After loading the data, the table in the Main Window will be filled with the file names and the entries of 

the covariate file (see 11.2.6.4). The table allows a quick check if the file order is correct, or whether it 

needs adjustment. In case the file order is incorrect, it is possible to move individual files or covariate 

entries within the according column by clicking on the file name and using the arrow buttons to move 

the content up or down (see 11.2.6.4). 

11.2.6.7. Loading Data that were created in BESA Research 

BESA Statistics expects the loaded data to conform to a certain format. Data that were created in 
BESA Research automatically follow the format requirements if they are exported the following way: 

Correct            Incorrect 

Data Factor 
Level n 

Data Covariate 
of no Interest n 

Subject 1 Subject 1 

Subject 2 Subject 2 

Subject 3 Subject 3 

Subject 4 Subject 4 

Subject n Subject n 
 

Data Factor 
Level n 

Data Covariate 
of no Interest n 

Subject 1 Subject 3 

Subject 2 Subject 1 

Subject 3 Subject 2 

Subject 4 Subject 4 

Subject n  
 

 

 

 

Correct            Incorrect 

EEG / MEG 
Data  

Data Covariate 
of Interest  

Subject 1 Subject 1 

Subject 2 Subject 2 

Subject 3 Subject 3 

Subject 4 Subject 4 

Subject n Subject n 
 

EEG / MEG 
Data 

Data Covariate 
of Interest 

Subject 1 Subject 3 

Subject 2 Subject 1 

Subject 3 Subject 2 

Subject 4 Subject 4 

Subject n  
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Data Type Extension Description Data export from BESA Research 

TFC ERP / 

ERF 

*.tfc; *.tfcs File containing results 

from TFC analysis on 

sensor level 

TFC Window:  

*.tfc: File / Export to ASCII File → Time Frequency 

Data Files 

*.tfcs: File / Export Single-Trial TF Data to ASCII 

File 

Additional File *.elp Electrode positions Main Window: File / Head Surface Points and 

Sensors / Save all Files in Head Coordinates3 

TFC SWF *.tfc, *.tfcs File containing results 

from TFC analysis on 

source level 

TFC Window:  

*.tfc: File / Export to ASCII File → Time Frequency 

Data Files 

*.tfcs: File / Export Single-Trial TF Data to ASCII 

File 

Additional File *.bsa Source positions Source Analysis Window: File / Save Solution As 

→ BESA Solution – Unit Sphere3 

Image *.dat File containing solution 

from distributed source 

analysis 

Source Analysis Window: Image / Export Image 

As → Image ASCII Files (optional: - all latencies) 

SWF *.swf File containing solution 

from discrete source 

analysis 

Source Analysis Window: File / Save Source 

Waveforms As → BESA Source Waveforms Files 

Additional File *.bsa Source positions Source Analysis Window: File / Save Solution As 

→ BESA Solution – Unit Sphere4 

ERP / ERF *.avr File containing event-

related potential / field 

data 

Main Window, marked segment: File / Export → 

Marked segment, ASCII Vectorized5 

Additional File *.elp Electrode positions Automatically exported with ASCII Vectorized 

data6 

Connectivity *.conn Connectivity data This data can be exported from BESA 

Connectivity. 

Covariate *.txt File containing 1 column 

with 1 numerical value 

per line (=subject) 

No export from BESA Research. 

11.2.6.8. Loading data that were created in other software 

Data exported from Brain Vision Analyzer 2 (ERP and time-frequency data with the extension *.vhdr, 

*.vmrk, *.dat) can be read directly by BESA Statistics. 

In case BESA Statistics is used for analyzing data created in other software, it is important to ensure 

that files are prepared to meet file format expectations. Please see chapter 18 for a detailed file format 

description. 

 
3 The sensor / source positions only need to be saved once per experiment, assuming that the same positions are 
used for all participants. Source orientations may differ across subjects as BESA Statistics does not display 
source orientations. BESA Statistics will use the first elp / bsa-file detected in the specified data folders. 

4 Coordinates must be in unit sphere. Talairach coordinates are not yet supported. 

5 Only segmented data are supported, continuous data cannot be analyzed in BESA Statistics. 

6 In case bad channels were defined, data were re-referenced or in case a montage was used that only contained 
a subset of channels, please refer to chapter 17.5 
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11.2.7. Set Parameters, Preliminary Test 

After successful loading of the data, the next workstep is Set Parameters. In order to access the 

parameter settings, the Preliminary Test (7.1) as defined in Project Targets (11.2.4) has to be run. 

Please note that results of the parametric preliminary test should not be interpreted in any way. 

The preliminary probability distribution is required for cluster-building. Parameters for clustering that 

will be used in the subsequent permutation test can be set in this workstep. They are to some degree 

dependent on the input data type (ERP / ERF, Image, SWF, TFC ERP / ERF or TFC SWF). In the 

following section, the elements of the Interaction Window will be described. 

11.2.7.1. Start time, End time (Start Frequency, End Frequency) 

Editing the Start time and End time and if applicable Start 

Frequency and End Frequency, the original data epoch will 

be adjusted accordingly. 

Defining a region of interest can increase the chance that a 

cluster will be significant after permutation. It will not alter the 

significance of the target cluster per se unless the selected 

start time (frequency) / end time (frequency) cut the cluster 

boundaries. Instead, the cluster value of the target cluster will 

have a different relative position in the cluster value 

distribution as derived by permutation (see 7.2) when a 

smaller region of interest is used. 

If averages over time are computed, the start time and end 

time selection will impact on the permutation test result. 

 

11.2.7.2. Statistical Settings 

The Neighbor Distance (circle arc length between two points, 

only available for sensor space data, i.e. ERP / ERF and 

TFC ERP / ERF) should be set to reflect the spacing between 

electrodes / MEG sensors. If the value is set correctly, BESA 

Statistics will only treat those electrodes / sensors as 

neighbors that are directly neighboring. If the value is set too 

low, no spatial clustering will be possible. If the value is set 

too high, clusters might become larger as also more distant 

electrodes / sensors are treated as neighbors. For image 

data, the neighborhood structure is given for a volume image 

consisting of adjacent voxels. I.e. the neighborhood 

information is automatically retrieved by BESA Statistics! 

For SWF data, no neighbor distance can be specified. The 

reason is that single dipoles and regional sources are discrete 

entities, i.e. they represent separate brain regions differing 

from each other in their activity pattern. Clustering them in 

space would destroy the advantageous property of discrete 

sources to separate brain regions. 

Cluster Alpha determines the significance level for building 

clusters in time and / or space / frequency (see below). As the 

preliminary test is run point-wise, every data point will be 

associated with a p-value. BESA Statistics looks for data 

clusters where the null-hypothesis can be rejected, i.e. only 

those data points are eligible to be part of a cluster, which fall 

below the Cluster Alpha value. Please note that the Cluster 
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Alpha value is not the significance level for the 

permutation test! It is only used for clustering. The larger the 

Cluster Alpha value, the larger the clusters. 

Number of Permutations determines, how many of all 

possible permutations (see 7.2) will be computed. If the 

number is smaller than the number of possible permutations, 

permutations are determined randomly, no repetitions 

allowed. If the number is larger than the number of possible 

permutations, BESA Statistics automatically corrects the value 

down to the maximum amount of possible permutations.  

It is possible to Average over Time and / or Frequency / 

Channels if desired. If selected, BESA Statistics will average 

across all available data-points of the selected dimension. 

Display Left defines what will be displayed in the left Detail 

Window. Display Top/Right defines what will be displayed in 

the Main Window and the right Detail Window (9.2). 

Select Channel (or Source / Extremum) allows the selection 

of a desired channel (TFC (ERP / ERF)) / source ((TFC) 

SWF) or extremum (Image) to be displayed in the Detail 

Windows via a drop-down menu. Alternatively, the channel / 

source / maximum of choice can be selected in the Main 

Window by a left-click. The arrow buttons left and right of the 

channel selector box can be used to quickly browse through 

all channels / sources / maxima. 

Current Latency allows setting a cursor at a particular 

latency (if TFC data are available, a Current Frequency can 

be selected additionally). The slider can be dragged to the 

point of interest or the arrow buttons at the left and right of the 

slider bar can be used to adjust the position. 

Set Scale (only ERP / ERF) allows adjusting the scaling of the 

topographic map in the Main Window. For t-Test, the map 

corresponds to either the difference between conditions or the 

corresponding t-values, depending on the selection under 

Display Top/Right. For ANOVA / ANCOVA, the map 

corresponds to either F-values or the average of the input 

groups / conditions. For Correlation, the map corresponds to 

either r-values or the average of the input condition.  A Reset 

button is available to return to default settings. 

 

Scale allows altering the scaling of the data. The arrow 

buttons at the left and right of the slider bar can be used to 

scale the data up or down. 

Zoom allows viewing the Main Window contents in greater 

detail. The arrow buttons at the left and right of the slider bar 

can be used to adjust the zoom factor. The black frame at the 

left of the Zoom slider displays the position of the currently 

displayed window fraction relative to the complete window. 

The frame can be left-dragged to another relative position. 

Alternatively, it is possible to left-drag the Main Window while 

holding down the control key. 
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1. The Main Window shows the result of the statistical analysis (t-values; F-values; r-values) 

• per time-point and channel (ERP / ERF),  

• time-point and voxel (image),  

• the source positions if source waveforms are analyzed, 

• or time-frequency point and channel / source (TFC ERP / ERF or SWF; Connectivity). 

2. The left Detail Window displays an overplot of groups / conditions of  

• the selected channel (ERP / ERF),  

• voxel (image), 

• or source (SWF).  

• For TFC and connectivity data, only one group / condition can be displayed at a time. If 

selected, masks indicating significant clusters determined from the preliminary test will be 

overplotted additionally. 

3. The right Detail Window displays either the difference between conditions or the corresponding 

t-values (t-Test), F-values or the average of the input groups / conditions (ANOVA / ANCOVA). 

For Correlation, the map corresponds to either the r-values or the average of the input condition. 
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11.2.8. Perform Statistics 

Pressing Run Statistics opens a window with a 

summary of the Statistical Settings. If 

applicable, it displays the number of neighbors 

found with the given neighbor distance 

(11.2.7.2). Further, the cluster alpha value is 

displayed, as well as the number of 

permutations. If these values need changing, it 

is possible to return to the Set Parameters 

workstep by pressing Cancel and the Previous 

button. Confirming the summary window with 

OK will start the permutation test. Please note 

that depending on the number of subjects, 

electrodes / sensors and data points, the 

computation might take several minutes. 

 

Results of the permutation test will be displayed optimized for the data type in the Main Window and 

the Detail Windows. 

ERP / ERF 

 

Image 

 

SWF 

 

TFC 

 

Connectivity  
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Figure 12.9.1 Visualization of significant data clusters obtained by permutation statistics 

Permutation results are data clusters that are now 

associated with a specific p-value. Up to 100 data 

clusters are listed. Significant clusters are labeled 

with stars in the first column of the permutation 

results: 

 

One-tailed t-Test, ANOVA / ANCOVA, 

Correlation 

Two-tailed t-Test 

★★★: p-values < 0.001 

★★: p-values < 0.01 and ≥ 0.001 

★: p-values < 0.05 and ≥ 0.01 

+: p-values < 0.1 and ≥ 0.05 

★★★: p-values < 0.0005 

★★: p-values < 0.005 and ≥ 0.0005 

★: p-values < 0.025 and ≥ 0.005 

+: p-values < 0.05 and ≥ 0.025 

If there is more than one cluster in the same category, clusters will have a different color to make them 

distinguishable. 

Clusters can be positive or negative (see 7.2) and are accordingly labeled + or - in the third column of 

the permutation results. For ANOVA / ANCOVA, clusters can only be positive as there are only 

positive F-values. 

Clusters can be selected to be visualized in the Main Window by setting a green tick-mark in the 

fourth column of the permutation results. Only selected clusters will be displayed. 

Positive clusters (see 7.2) are marked by light red bars (ERP /ERF, image, SWF) or voxel masks 

(TFC). Negative clusters are marked by light blue bars or voxel masks (TFC) in the Detail Windows. 

The currently selected cluster is colored dark red or dark blue. 
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The remaining settings in the Interaction Window are analogue to the Set Parameters worksteps 

(11.2.7) with the difference that “Mask” now only refers to selected clusters to be visualized. 

Pressing Finish saves the current project. 

After specifying a group and project name, projects including 

all completed workflows steps will be saved and marked with 

a green arrow. Completed, but not finished projects are 

marked by a green dot. Incomplete projects are marked by a 

red dot.  

A project can be re-opened at any time by pressing File / 

Open Project 

 

11.2.9. Post-Hoc Testing – ANOVA / ANCOVA only 

After finishing the Perform Statistics workstep in the 

ANOVA / ANCOVA workflow and (only) if clusters 

were identified that reject the null-hypothesis of 

exchangeability of groups / conditions, i.e. that 

show a significant main effect in the ANOVA / 

ANCOVA, it is necessary to run post-hoc tests in 

order to find out, which pairwise comparisons were 

responsible for the main effect (7.1.2). 

Pressing Run Post-Hoc Tests will initialize the 

computation of pairwise comparisons with Scheffe’s 

test (7.3). Post-hoc testing also follows the cluster-

permutation logic (7.2). Therefore, a permutation 

test is computed for each pairwise comparison, the 

significance level being adjusted following 

Bonferoni-Holm (7.3). Please note that computation 

might take a while, depending on the number of 

pairwise comparison and data size. 
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Results for the Post-Hoc tests can be displayed for 

each pairwise comparison following the same logic 

as described in the Perform Statistics workstep 

(11.2.8). 

 

 

In the drop-down menu Display Top/Right, it is now possible to either select F-values for the current 

pair-wise comparison or Difference in order to display the mean difference between the input groups / 

condition of the current pair-wise comparison. 

11.3. Important Dialogs 

This section describes important user interactions realized by dialogs. 
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11.3.1. Select the BESA Statistics Data Folder 

If required, you may switch to different or create a new BESA Statistics Data Folder by selecting the 

menu item File → Select Data Folder. In the dialog box below, select an existing folder to store all 

result data of BESA Statistics or create a new folder accessible to all users in your workgroup: 

Select a folder in this dialog and press Select Folder to set this folder as the current BESA Statistics 

Data Folder. After selecting a new BESA Statistics Data Folder, the following confirmation dialog 

appears: 

 

Press OK to activate the new BESA Statistics data folder. 

It is recommended to leave the tick mark on to update all existing projects in the new BESA Statistics 

Data folder, if you switch between folders. 

Note: When switching between different BESA Statistics Data folders, the project data are preserved 

in each folder and are not copied to the new folder. 

11.3.2. Open Projects 

The Open Project dialog box shows the available projects. Project type can be selected using the 

Project Type option in the dialog box. The left pane shows Group, and the right pane shows all 

projects available for that Group, with their modification date. 

 

The previously used project is automatically selected. 

Icons in the list of projects: 

• Green tick mark: The project has been finalized. 
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• Green circle: All steps have been computed, but the project has not yet been finalized. 

• Yellow circle: All manual steps have been completed, but the project is still in progress.  

• Red circle: Some manual steps have not yet been completed. 

Icons in the list of subjects: 

• Green tick mark: All projects of this subject have been finalized.  

• Green circle: All steps have been completed for all projects of this subject, but at least one 
project has not yet been finalized. 

• Yellow circle: All manual steps have been completed, but at least one project is still in 
progress. 

• Red circle: For at least one project, some manual steps have not yet been completed. 

After opening a finalized project, the project is unlocked and run through the worksteps automatically. 

 

11.3.3. Finish, Save, and Close Projects 

11.3.3.1. Finish a project 

The Save Project As… dialog box comes up proposing a group name if the project is new (see figure 

below). If a previous project has been opened and modified, the previous name is proposed. 

The selected group and proposed project names are highlighted automatically. To save under a 

different project name, the user enters a new project name in the Selected Project edit field. 

Pressing the Save button stores the project data. If the selected project name does not yet exist, the 

project is saved with all result files automatically.  

 

If the user keeps the highlighted project name of a previous project or selects another previous project 

name of the current subject in the Projects selection box on the right, he/she will be asked whether to 

replace the previous project by the new project data: 



 

How to use BESA Statistics  

44  

 

• Yes discards the previous project data and stores the new data under the previous project 

name. 

• No saves under a different project name. The Save Project As… dialog box comes up again. 

11.3.3.2. Close a project 

At any time during the workflow, you may close the current project using the Close button in the 

toolbar or the menu item File → Close. 

When closing a project, the following dialog box comes up: 

 

Press Yes to save the changed project data. Previously stored data will be overwritten. 

Press No if you want to discard all changes, e.g. when accidentally modifying user defined parameters 

during reinspection after opening an existing project. In this case, the stored data of the current, 

previously saved project will not be overwritten and changes to the project will not be stored.  

Press Cancel to return to the project workflow, e.g. if you want to save the current changes under a 

new project name using the menu item File → Save As. 

11.3.3.3. Save a project 

At any time during the workflow, data can be saved by selecting the menu item File → Save or typing 

Ctrl+S. However, previously stored data will be overwritten automatically. 

Notes on closing and saving: 

1. Closing and saving can be done at any time during the preparation of a project to preserve the 
user input up to the completed workstep. 

2. If a previously completed project has been opened, previous project data will be overwritten and 
replaced by the current state of the project. Therefore, do not use the save function when 
opening a previous project simply for inspection. In this case, use the menu item File → Save 
As. 

3. Select the menu item File → Save As to store a modified project under a new project name. 

4. The current project name can always be seen in title bar. 

11.3.4. Delete Projects 

Stored BESA Statistics projects can be deleted if no longer needed. To delete a project, select the 

menu item File → Delete Projects…. The Delete Projects… dialog box appears: 
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In the Project Type drop down selection box at the bottom, select the type(s) of projects to be deleted. 

Select All Projects to delete segmentation and coregistration projects. 

In the Group selection box, mark a group for which project data shall be deleted. Then, select the 

projects to be deleted in the Projects selection box (multiple Groups or Projects can be selected by 

holding the Ctrl or Shift key while selecting). 

A confirmation box is displayed, after selecting and pressing Delete. 

Press Yes if you do not need the listed project data any more. Restoring is no longer possible after 

deleting. Press No to prevent deleting. 

11.3.5. Select Files 

When selecting input data, the following dialog appears: 

  

The drop-down menu Files name allows choosing different file type. 

Use the drop-down folder list at the top to navigate to the desired input folder. Then, select files in the 

current folder and press Open. 
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12. Specific Issues when Analyzing ERP / ERF data 

12.1. Load Data 

When ERP / ERF data are loaded, BESA Statistics expects 

the file format *.avr (see 11.2.6.7) or the format *.vhdr for data 

created in BrainVision Analyzer 2.  

Please note that in case EEG or MEG data in the *avr 

format are analyzed, one of the folders must contain a 

channel position file (*.elp; see 11.2.6.7). 

 

12.2. Set Parameters 

The Neighbor Distance should be specified according to the 

current channel layout. As different EEG caps will have a 

different number of electrodes with different mean distances, 

each electrode cap will require a particular Neighbor Distance. 

The same is true for MEG systems. The summary window in 

the Run Statistics worstep allows inspecting the correctness of 

the Neighbor Distance. 

 

12.3. Perform Statistics 
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When analyzing sensor space data, the permutation test can 

reveal several clusters where the null-hypothesis must be 

rejected, i.e. the groups / conditions / subjects are not 

interchangeable. Please note that it is possible that different 

clusters may reflect the same underlying effect, e.g. the 

positive and negative field resulting from underlying dipolar 

activity of the same generator inside the brain. These clusters 

should not be interpreted separately (see Important note 

on the Interpretation of Clusters in chapter 7.2). 

 

13. Specific Issues when Analyzing Source 
Waveforms 

13.1. Load Data 

When source waveform data are loaded, BESA Statistics 

expects the file format *.swf (see 11.2.6.7). 

Please note that when SWF data are analyzed, one of the 

folders must contain a source position file (*.bsa, see 

11.2.6.7). 

 

13.2. Set Parameters 

No Neighbor Distance can be set as individual sources are thought to reflect activity in discrete 

cortical patches. Grouping discrete sources would lead to misleading results. Thus, clusters will only 

be built within each individual source. Please note that each orientation of a regional source is 

considered as a separate source, as each orientation represents a different cortical patch as illustrated 

in the example below. 
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13.3. Perform Statistics 

 

Permutation test results will be clusters where the null-hypothesis is rejected, i.e. data are not 

interchangeable. By default, BESA Statistics automatically selects the cluster and the corresponding 

source / orientation with the largest t-/F-/r- value for visualization in the Detail Windows. 

14. Specific Issues when Analyzing Time Frequency 
Data 

Start BESA Statistics and press Start new Project. 

14.1. Set Project Targets 

It is possible to analyze TFC results based on source 

montages (SWF) or based on channels in sensor space (ERP 

/ ERF). If the latter is selected, it is necessary to choose 

between EEG, MEG, intra-cranial (ICR) and polygraphic data 

(POL). 
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14.2. Load Data 

If TFC analysis is performed on ERP / ERF EEG and MEG 

data files (*.tfc; *.tfcs) that were created by BESA, the data 

should be associated with a channel position file (*.elp, 

see 11.2.6.2) so that BESA Statistics can display the channels 

at their correct position and also retrieve the correct 

neighborhood information for spatial clustering. ICR and POL 

data are not associated with a channel position file and no 

spatial clustering will be computed. 

TFC analysis based on source montages (SWF) should be 

associated with a source position file (*.bsa, see 11.2.6.7) 

so that BESA Statistics can display the sources at their correct 

position. 

 

 

14.3. Set Parameters 

 

Once preliminary statistics are computed, an electrode / sensor of interest can be selected by either 

left-clicking on it in the Main Window or by using the Select Channel (or Source) drop down box in 

the Interaction Window. The selected channel is marked by a frame. Please note that you can quickly 

browse through the channels using the arrow buttons to the left and right of the Select Channel drop-

down box. The selected channel will be displayed in the left and right Detail Windows. 

A crosshair can be placed at a time-frequency point of interest by entering a latency (in ms) / 

frequency (in Hz), dragging the Current Latency / Current Frequency slider or using the left and 

right arrow buttons next to the sliders in the Interaction Window. 
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Display Left in the Interaction Window defines what is being displayed in the left Detail Window. By 

default, Group / Condition 1 and Group / Condition 2 will be displayed along with a Mask indicating 

sifnificant time periods. Time-frequency ranges, during which  group / condition 1 has smaller values 

than condition 2 are displayed in blue. Time-frequency ranges, during which group / condition 1 has 

larger values than condition 2 are displayed in red. If desired, the mask as well as each of the groups / 

conditions can be switched off by un-checking the tick-mark in the according selector boxes. 

Display Top/Right in the Interaction Window determines what will be displayed in the right Detail 

Window and the Main Window. A selection can be made between Difference, i.e. the difference 

between groups / conditions or the according T-/F-/R-Values. It is also possible to display the Mask of 

significant time-periods in the right Detail Window analogue to the left Detail Window.  

In case TFC data based on EEG / MEG channels are analyzed, the Neighbor Distance should be 

specified according to the current channel layout. As different EEG caps will have a different number 

of electrodes with different mean distances, each electrode cap will require a particular Neighbor 

Distance. The same is true for MEG systems. The summary window in the Run Statistics workstep 

allows inspecting the correctness of the Neighbor Distance. 

If desired, the Start Time / Start Frequency and End Time 

/ End Frequency can be adjusted.  

 

When analyzing TFC data it is possible to Average over 

Time, Average over Channels and Average over 

Frequency. 

 

14.4. Perform Statistics 

Please note that running the permutation test on TFC data 

can take several minutes depending on the number of 

subjects, channels, and time-frequency bins. 
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Permutation test results will be clusters where the null-

hypothesis is rejected, i.e. data are not interchangeable. By 

default, BESA Statistics automatically selects the cluster and 

the corresponding source / orientation with the largest t-/F-/r- 

value for visualization in the Detail Windows. 

All channels belonging to a cluster are overlaid with the 

according cluster mask, if the mask is displayed. 

 

14.4.1. Time-Frequency Mapping in TFC ERP / ERF Data 

If a t-Test or a correlation project was chosen and permutation testing was run on sensor space TFC 

data (TFC ERP / ERF), it is possible to display a topographic map of the mean difference between 

input groups / conditions (t-Test) or the mean of the input group / condition (correlation) for TFC 

clusters. This feature can be helpful in order to investigate, what the distribution of the original sensor 

space data was that led to a significant effect in the time-frequency domain for t-Testing or correlation. 

By default, the mean values displayed in the TF map are based on the time and frequency range of 

the selected cluster. Start Time / End Time, as well as Start Frequency / End Frequency are 

automatically set to these boundaries when a cluster is selected, and can be changed within the 

boundaries set by the cluster. 
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15. Specific Issues when Analyzing Image Data 

15.1. Load Data 

When analyzing Image data, BESA Statistics expects *.dat 

files (11.2.6.7). Each file can contain voxel information on 1 

time-point or a time-series. No additional files are required. 
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15.2. Set Parameters 

 

Depending on the parametric test chosen, the main window displays activity in the input groups / 

conditions, the activation difference between groups / conditions (t-Test only), and statistical values (t-

values, F-values, r-values), based on the selection under Display Image. 

If an ANOVA / ANCOVA is calculated, the main window displays the preliminary F-values in the first 

row, the second and third row display groups / conditions as selected by the user in the Display 

Image drop-down menu. Please note that a maximum of two groups / conditions can be selected at a 

time. If the group / condition selection is altered by the user, the previous selection must first be un-

done by  un-ticking the according group / condition. 

Once preliminary statistics are computed, it is possible to select a voxel of interest by using the Select 

Extremum drop down box in the Interaction Window. The selected voxel is marked by a crosshair. 

Please note that you can quickly browse through the extrema using the arrow buttons left and right of 

the Select Extremum drop-down box. The activation time-course of the selected extremum are 

displayed in the left and right Detail Windows. Additionally, Talairach coordinates of the selected 

extremum are displayed at the bottom of the Interaction Window. 

Please note that it is not possible to specify a Neighbor Distance for image data. The reason is that 

the neighborhood structure is given for a volume image consisting of adjacent voxels. I.e. the 

neighborhood information is automatically retrieved by BESA Statistics! 

15.3. Perform Statistics 

Please note that running the permutation test on Image data 

can take several minutes depending on the number of subjects 

and time-points. 
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Permutation test results will be clusters where the null-hypothesis is rejected, i.e. data are not 

interchangeable. By default, BESA Statistics automatically selects the cluster and the corresponding 

source / orientation with the largest t-/F-/r- value for visualization in the Detail Windows.  

If an ANOVA / ANCOVA is calculated, the main window displays the clusters in the first row, the F-

values in the second and third row display groups / conditions as selected by the user in the Display 

Image drop-down menu. Please note that only one group / condition can be selected at a time. If the 

group / condition selection is altered by the user, the previous selection must first be un-done by  un-

ticking the according group / condition. 

15.4. Multi-Slice view 

A convenient way to review image date and export it in graphical form is a multi-slice view. To enable 

multi-slice view, check the Slice View button in the Interaction Window of the Perform Statistics or 

Post-Hoc Statistics workstep. 
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The display matrix can be adjusted by additional controls that are shown after enabling slice view. One 

of these slicing directions can be selected: Transverse, Coronal, Sagittal. By adjusting First slice 

and Last slice sliders, the span of the volume that will be displayed can be adjusted. The interval 

between slices can be adjusted by changing the Spacing slider value. The layout of slices will be 

automatically adjusted to fill the full space of the main window. All values in the sliders are given in 

mm. 

Note: The last slice value will be adjusted to the closest possible number matching the given first slice 

and spacing value. 
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16. Exporting Images and Results 

16.1. Exporting Images 

After running preliminary statistics or after the Perform Statistics workstep is finalized, it is possible to 

export resulting images in the main window and the detail windows. This can be achieved via the 

menu bar (see 10.1.4) or via the context menu Export (right-clicking in the corresponding window). 

 

Images can be saved as portable network graphics 

(*.png), vector graphics (*.eps), or scalable vector 

graphics (*.svg). 

The selection can be made in the “Save Image As…” 

dialog under Save as type section. 

 

When saving *.png files, the dimension and resolution of 

the resulting image can be defined. By default, the 

current size of the image on the screen is used. Width 

and height can be altered with or without constraining 

proportions using mm or inch as units. The resolution 

can be set to 150, 300 or 600 dots per inch. 

When saving *.eps or *.svg files, the image size cannot 

be changed as vector graphics are by definition fully 

resizable.  

 

16.1.1. Capture Images 

The main, left detail, and right detail windows can be captured to the clipboard using the context menu 

Capture This Window and Capture All Windows (right-clicking in the corresponding window). 
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The windows can be also captured to the clipboard using the following shortcuts. 

• Ctrl + C: capture a window under the mouse cursor 

• Ctrl + Shift + C: capture all windows 

16.2. Exporting Statistical Results 

After the Perform Statistics workstep is 

finalized, it is possible to export statistical 

results via the menu bar (see 10.1.4). A choice 

can be made between Summary of Cluster 

Statistics and Detailed Results per Cluster. 

The resulting files are comma-separated (*.csv). 

 

Summary of Cluster Statistics will output the 

cluster value, p-value, cluster boundaries and 

means for conditions, maximum t/F-value, 

latency, frequency, channel and position at 

maximum for each cluster found. For ERP/ ERF 

and TFC data, labels of the channels that are 

associated with a cluster are also exported. For 

ANOVA project both main effect and post-hoc 

per pair output is exported 

Similar results can be also displayed in the 

Information window, and the text in the 

information window can be copied to the 

clipboard via the context menu Copy Text to 

Clipboard. 

 

 

Detailed Results per Cluster will output mean 

values per person and group/condition for each 

cluster. 

 
 

Important Note on mean values derived from ANOVAs / ANCOVAs 

When ANOVA / ANCOVA is used as preliminary test, clusters are derived based on F-values. F-

values can only be positive, irrespective of the underlying data having positive or negative values. For 

example, an F-test cluster can be identified in MEG sensors picking up activity of dipolar fields, i.e. 

some sensors will be associated with positive and some with negative values. Exporting mean values 

for the cluster can then result in values around 0. Therefore, mean values based on F-test clusters 

should be interpreted with caution.  
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17. Appendix  

17.1. The BESA Statistics Data Folder 

The BESA Statistics Data Folder is the folder or path where BESA Statistics stores all project data to 

and reads completed or prepared projects from. This folder should exclusively be used for storing 

BESA Statistics data. 

When starting BESA Statistics for the first time (5.3.2), a local folder accessible to all users is 

suggested as the default folder. Depending on the operating system, this folder is located as follows: 

• Windows 10:   C:\Users\Public\Public Documents\BESA Statistics\Projects\ 

In most cases, however, it might be more useful to create a shared folder on a server drive, e.g. 

E:\Server\BESA Statistics Data that is accessible to all users from anywhere in the local network. 

This is more convenient, since BESA Statistics uses a network license key allowing the software to be 

run from any computer in the local network where BESA Statistics has been installed and configured 

with the shared BESA Statistics Data folder. 

Note: 

• If you have a multi-license installation, make sure that two users do not work on the same Group 

and Project at the same time. Currently, BESA Statistics does not lock projects within the 

network. 

• If there are several major research studies with different Groups, you might want to create 

separate folders to store the data of the different studies separately. BESA Statistics offers the 

choice to switch between different BESA Statistics Data folders (see chapter 11.3.1) by 

selecting the menu item File → Select Data Folder. 

• When switching between different BESA Statistics Data folders, the project data are preserved 

in each folder and are not copied to the new folder. Thus, you may have to run computation 

twice unless you copy the subject’s subfolder to the new BESA Statistics Data folder using, 

e.g. Windows Explorer, and update the Data Folder Information as described below. 

17.2. The BESA Statistics Data Folder Information File 

For faster access on the different projects in the BESA Statistics Data Folder, an information file called 

Data Folder Info is created in the subfolder BesaInternal within each BESA Statistics Data folder. The 

Data Folder information stores the Group and Project file names of all projects in the BESA Statistics 

Data folder. 

After copying or moving Group data folders from a previous to a new BESA Statistics Data folder 

using, e.g. Windows Explorer, update the Data Folder information by selecting the menu item File → 

Update Data Folder Info. When switching between folders, make sure that the tick mark of the 

update option stays on in the confirmation dialog box (see chapter 11.3.1). 

17.3. Group-based Data Management 

All project data of a Group are stored in one subfolder of the BESA Statistics Data folder having the 

composed folder name StatGroup_<GroupName>. Project data are stored on a project name basis. 

Project data are managed by BESA Statistics using special dialogs for opening, saving or closing, and 

deleting projects (see chapter 11.3). These dialogs provide a Group- and project-based selection of 

completed or prepared project data. 
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17.4. The configuration file (*.cfg) 

Some settings can be adjusted in the BESA Statistics.cfg file, located in: 

• Windows 10:  C:\Users\<USER>\AppData\Local\BESA Statistics\Settings\ 

17.5. How to deal with bad channels when analyzing ERP / ERF data 

By default, BESA Statistics only utilizes information about EEG / MEG channels configurations as 

available in the elp-file (see 11.2.6.7 and 18). The elp-file does not contain information on channel 

status, e.g. channels that were excluded from analysis in BESA Research by setting them as bad. 

Thus, all channels that were previously defined as bad will still be used by BESA Statistics. This might 

not be desirable, as the channels might contain flawed data. 

On the other hand, it can be a problem for cross-subject statistics if bad channels are defined and 

shall be excluded. If different bad channels are defined for different subjects, the number of channels 

does not match across subjects. This is a requirement for cross-subject statistics as it is implemented 

in BESA Statistics, however. There are two ways to deal with this problem: 

17.5.1. Interpolating bad channels in BESA Research 

The easiest solution might be to interpolate all bad channels in BESA Research by right-clicking on the 

channel label and choosing “Interpolate this channel” rather than “Define channel as bad”. 

Alternatively, you can press “Edit / Bad Channels” and double-click on all channel labels in the right 

panel. This will also lead to bad channels being interpolated. After interpolation you should export 

(“File / Export”) the data with the setting “Current Montage”. This will lead to BESA Research 

outputting the interpolated EEG / MEG channel traces rather than the flawed data of the bad channels. 

17.5.2. Creating a channel montage only containing good channels in BESA Research 

If you want to omit bad channels from statistical analysis, you should create a new channel montage in 

BESA Research. With a concerned dataset open, press “Edit / Montage” to open the montage editor. 

In the middle pane you can now delete all channels you want to omit from statistical analysis by right-

clicking and selecting “Delete montage channel …”. Save the newly created montage by pressing “File 

/ Save Montage as”. Please specify a name of your choice. This user-montage can now be applied to 

the datasets of all subjects that should enter statistical analysis by pressing the USR button and 

selecting the according montage for each dataset. 

The data can now be exported for statistical analysis (“File / Export”) with the settings “ASCII 

vectorized” and “Current Montage”. This will make sure that all subjects are associated with the same 

number of channels. 

What you will need to do additionally is to export a new elp-file containing only information about the 

channels in the montage. To do so, make sure that the montage you want to use is applied on the 

data. Next, press “File / Head Surface Points and Sensors / Save Electrode File for Current 

Montage”. This will make sure that the number of channels and the labels of the used channels are 

identical in the exported data and the elp-file. 

17.6. How to deal with re-montaged or re-referenced data 

In case you have already created a channel montage only containing channels of interest or if you are 

dealing with re-referenced data, you should follow the same procedure as outlined in chapter 17.5.2., 

second and third paragraph.  
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18. File Formats 

In case BESA Statistics is used for data created in other software, files need to be prepared to meet 

file format expectations. 

In the following we describe the requirements which data created using other software should meet to 

be compatible with the BESA Statistics data formats described in the table of section 11.2.6.7. All 

BESA Statistics data formats are in ASCII format to facilitate human readability. All floating-point 

numbers are represented in scientific notation with up to eight significant digits. An exception to this 

rule is the BrainVision Analyzer 2 data formats that are supported (*.vhdr files; for a format description 

please consult the manual of the BrainVision Analyzer 2 software). 

18.1. The BESA Statistics Time-Frequency File Format (*.tfc) 

The header line contains the following data descriptors (13 descriptors displayed in bold, the values 

shown are only examples and comments are in italic): 

1. VersionNumber=__v_5.1: Version number of the current software. 

2. DataType=COHERENCE_SQUARED: Data type contained of the file. Possibilities are: 

• COHERENCE_SQUARED: coherence values squared. 

• ERDERS_AMP: ERD(event-related desynchronization) and ERS(event-related 
synchronization) amplitudes. 

• ERDERS_POWER: power. 

• ERDERS_AMP_P_VALUE (not allowed for BESA Statistics) 

• ITPL: Inter-trial phase locking is a measure for the phase consistency of the oscillatory 
response of a single surface or source channel across multiple trials. 

• PHASE_COHERENCE: phase coherence. 

• ERDERS_AMP_P_VALUE (not allowed for BESA Statistics) 

• TIME_FREQUENCY_AMP: time frequency amplitude. 

• TIME_FREQUENCY_POWER: power. 

3. ConditionName=s:Condition name.  Usually indicated by experiment. E.g. "high-" or " low 
intensity". 

4. NumberTrials=250: Number of trials. 

5. NumberTimeSamples=25: Number of time samples. 

6. TimeStartInMS=-100.0: Start time in [ms]. 

7. IntervalInMS=25.0: Interval length in [ms]. 

8. NumberFrequencies=24: Number of frequency bins. 

9. FreqStartInHz=4.0: Starting  frequency in [Hz]. 

10. FreqIntervalInHz=2.0: Frequency interval in [Hz]. 

11. NumberChannels=127: Number of channels in the data set. 

12. StatisticsCorrection=Off: Statistics correction flag. 

13. EvokedSignalSubtraction=Off: Flag to signal evoked signal subtraction (On if evoked signal 
is subtracted, Off otherwise). 

The second row of the header contains the labels of the channels. Their labeling can be chosen freely 

provided only letters and number are used and the amount of characters per entry does not exceed 

eight (e.g. E1 E2 ... for electrodes). 
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The remaining lines contain NumberChannels blocks starting from the first channel. Each block is 

separated from the next one by an empty line. Each block contains NumberFrequencies-rows and 

NumberTimeSamples-columns. The values for each time-frequency entry in the blocks are floating 

point numbers and should be separated by a tab. 

18.2. The BESA Statistics Single Trial Time-Frequency File Format 
(*.tfcs) 

The file is created without a header. The start of each trial export is indicated by the text “Trial” 

followed by the trial number. The Trial statement also separates trials in the exported file. Every time-

frequency matrix (block) is preceded by the channel number, and the Channel statement separates 

blocks. The time-frequency data points are reported as complex numbers. Each block is organized in 

a table where columns represent time points (increasing from left to right) and rows represent 

frequencies (increasing from bottom to top). Columns are separated by tabulators. 

14.1. The BESA Statistics Channel Definition File Format (*.elp) 

Each line of the channel definition file contains one label, an identifier and 2D coordinates. 

The format is: IdentifierLabel Theta-coordinate Phi-coordinate 

Identifiers can be: 

• EEG - scalp electrode (use also instead of SCP). 

• POL - polygraphic channel (use also instead of PGR). 

• ICR - intracranial electrode. 

• MEG - MEG sensor. 

• REF - reference electrode. This can only occur once. 

Labels should have at most 8 characters and be constituted only by letters and numbers, but can 

otherwise be chosen freely. Note though that the corresponding *.avr files (see 18.6) have to use the 

same convention for the label naming. 

Coordinates are represented as floating point numbers in [deg] in the unit sphere coordinate system. 

This coordinate system is defined by reference points on the head known as fiducials. The reference 

points are normally the nasion (NAS), the left preauricular point (LPA), and the right preauricular point 

(RPA). The x axis is defined by the line joining LPA and RPA, positive towards RPA. The y axis is 

defined by the line through NAS that is perpendicular to the x axis (positive towards NAS). The z axis 

is perpendicular to the x and y axes, and goes up out of the upper part of the head (e.g. Cz). The 

Theta-coordinate (azimuth) is zero at the z axis, 90 deg at the x axis and -90 deg at the negative x 

axis. The Phi-coordinate instead goes from [-90 deg, 90 deg] from the negative y axis to the positive y 

axis for positive theta (i.e. for the right hand side of the scalp), while it goes from [90 deg, -90 deg] 

from the negative y axis to the positive y axis for negative theta (i.e. for the left hand side of the scalp). 

18.3. The BESA Statistics Solution File Format (*.bsa) 

The file contains the position and orientation of dipoles/sources.  

The first line of the file contains a dummy identifier BSA_1.04.19990715. 

The second line of the file contains the labels: Type, x-loc, y-loc, z-loc (the position of the 

dipole/source in unit sphere Cartesian coordinates), x-ori, y-ori, z-ori (the unit vector orientation of the 

dipole/source).  

This coordinate system is defined by reference points on the head known as fiducials. The reference 

points are normally the nasion (NAS), the left preauricular point (LPA), and the right preauricular point 
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(RPA). The x axis is defined by the line joining LPA and RPA, positive towards RPA. The y axis is 

defined by the line through NAS that is perpendicular to the x axis (positive towards NAS). The z axis 

is perpendicular to the x and y axes, and goes up out of the upper part of the head (e.g. Cz).  

Type can assume the values: 

1. SngDip - single dipole. 

2. RegSrc - regional source. 

3. RegBFVS – regional beamformer virtual source. 

18.4. The BESA Statistics Image File Format (*.dat) 

Source analysis files are used to store a number of possible scenarios: 

• Image ASCII Files: Image amplitudes of all grid points in the currently displayed image in the 
current image resolution.  

• Image ASCII Files - all latencies: Image amplitudes of all grid points in the current image 
resolution for all time points.  

The header looks like the following example (required labels are in bold, comments are in italic and all 

other text serves as sample input): 

BESA_SA_IMAGE:2.0 

Data file:          C:\ExampleDirectory\exampleFile.foc: Meta information.  

Condition:          s  Low Filter: 0.5 Hz: Condition name, usually specified by the 
experiment.  

Method:             Standard LORETA: Used method. See below. 

Regularization:     First: SVD 0.0050Iterations: SVD 0.0050;: Meta information. 

  nAm/cm^3 

Grid dimensions ([min] [max] [nr of locations]): 

X: -73.500000 73.500000 22: Min, max and number of points along the X axis. 

Y: -107.930000 74.070000 27: Min, max and number of points along the Y axis. 

Z: -60.340000 79.660004 21: Min, max and number of points along the Z axis. 

===================================================================
== 

Method can assume the following values: 

• MSBF  

• CLARA 

• Standard LAURA 

• Standard LORETA 

• Standard sLORETA 

• Standard swLORETA 

• Standard SSLOFO: 3 iterations, clip 10, smooth 1.0; 

The data section following the header is composed of matrixes of nr of locations - of X columns and 

Y rows with values for each voxel at this slice (where the slice is indexed by Z). There are nr of 

locations (specified in the header for Z) slices and the index starts at zero.  Slices are separated from 

each other by an empty line. 

The data section for Image ASCII Files will look like e.g.: 

 . 
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 . 

Z: 12 

0.0000000000 0.0000000000 0.0000000000 0.0000000000 ... nr of locations of X entries. 

0.0000000000 0.0000000000 0.0000000000 0.0000000000  

0.0000000000 0.0000000000 0.0000000000 0.0000000000  

0.0000000000 0.0000000000 0.0000000000 0.0000000000  

0.0000000000 0.0000000000 0.0000000000 0.0000000000  

0.0000000000 0.0000000000 0.0000000000 0.0000000000  

0.0000000000 0.0000000000 0.0000000000 1.1316120625  

0.0000000000 0.0000000000 0.0000000000 1.6725080013  

0.0000000000 0.0000000000 1.0726528168 2.2005338669  

0.0000000000 0.0000000000 1.5812959671 2.8961703777  

0.0000000000 0.0000000000 2.1061606407 3.6263871193  

0.0000000000 0.0000000000 2.6111714840 4.3519711494  

0.0000000000 0.0000000000 2.8889267445 4.7082519531  

0.0000000000 0.0000000000 2.8630757332 4.6019945145  

0.0000000000 0.0000000000 2.5799186230 4.1517233849  

0.0000000000 0.0000000000 2.1543741226 3.4361450672 

. 

. 

... nr of locations of Y entries. 

. 

For each time sample the corresponding data block starts with the label Sample and the number of 

the current sample e.g. 1, and after a comma separator follows the latency in milliseconds followed by 

the  unit label "ms". Furthermore, the amount of equal signs (‘=’) to limit each latency sample is 94. 

The data section for Image ASCII Files - all latencies - all latencies will look like e.g.: 

. 

. 

. 

Sample 1, 0.00 ms 

Z: 0 

0.0000000000 0.0000000000 0.0000000000 0.0000000000 ... nr of locations of X entries. 

. 

. 

... nr of locations of Y entries. 

 

 Z: 1 

. 

. 

. 



 

File Formats  

64  

 

============================================================================================== 

Sample 2, 4.00 ms 

Z: 0 

. 

. 

. 

18.5. The BESA Statistics Source Waveforms File Format (*.swf) 

The header line contains the following data descriptors (8 descriptors displayed in bold, separated by 

blank spaces, the values shown are only examples. Comments are in italic.): 

1. Npts= 200: number of sampled points in each channel. 

2. TSB= -500: time sweep begin [ms]. Time of first data point relative to zero of epoch. 

3. DI= 5: digitization or sampling interval [ms]. 

4. SB= 1: default scaling bins/nAm in file. 

5. SC= 200: default scaling calibration. 

6. CondFile= "OrigFile.fsg": Name of the original bin file. 

7. CondName= "S1:  100 avs": Condition name, usually specified by the experiment. 

8. Filter= "Filters off": status of the filters.  

Each remaining line begins with the name of the source followed by floating point values for all Npts 

time points. 

In the case of regional sources which were oriented before the export, we obtain three rows for each 

source (one for each orientation). 

18.6. The BESA Statistics ERP / ERF ASCII Vectorized File Format (*.avr) 

The first of two header lines contains the following data descriptors (7 descriptors, the values shown 

are only examples): 

1. Npts= 200: number of sampled points in each channel. 

2. TSB= -500: time sweep begin [ms]. Time of first data point relative to zero of epoch. 

3. DI= 5: digitization or sampling interval [ms]. 

4. SB= 1: default scaling bins/nAm in file. 

5. SC= 200: default scaling calibration. 

6. Nchan= 27: number of channels. 

7. SegmentName= 60dB : an optional label describing the data. 

The second line of the header contains the labels for each channel separated by a blank space. They 

can be chosen freely; however, they have to correspond to whatever convention was used in the 

corresponding (see 14.1). 

Each of the subsequent Nchan lines of the file contains floating point values for all Npts time points. 

18.7. The BESA Statistics Connectivity File Format (*.conn) 

The file contains connectivity data. The header line contains the following data descriptors (descriptors 

displayed in bold, the values shown are only examples and comments are in italic): 
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VersionNumber = 1.0: Version of file format standard 

DataType = Coherence: Connectivity analysis method 

DecompositionType = Complex Demodulation: Decomposition type used during time-frequency 

analysis 

ConditionName = Cond1: The name of the condition 

NumberTrials = 218: The number of trials used during analysis 

NumberTimeSamples = 25: The number of time samples 

TimeStartInMS = -350.0000: The starting time position – the first available time point in 

milliseconds 

IntervalInMS = 50.0000: The time interval expressed in milliseconds 

NumberFrequencies = 59: The number of frequencies 

FreqStartInHz = 2.0000: The starting frequency –the first available frequency in Hertz 

FreqIntervalHz = 1.0000: The frequency interval expressed in Hertz (only relevant for complex 

demodulation) 

NumberChannels = 11: The number of channels 

Frequencies = 4.00;4.47;4.98;…: The frequencies used (only used for wavelets). 

The second row of the header contains the labels of the channels / sources.  

The remaining lines contain connectivity data. Data is divided into blocks (2D tables). The number of 

tables is equal to NumberChannels to the power of 2 since every channel is compared with all other 

channels (including itself, but here all connectivity values are equal to 1). Each block is separated from 

the next one by an empty line. Each block contains NumberFrequencies-rows and 

NumberTimeSamples-columns. The values for each time-frequency entry in the blocks are floating 

point numbers and are separated by a tab. 
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